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Preface

iNotes Web Access is a next-generation Web client that allows you to utilize the
most popular Domino functionality with a Web browser. You can work on your
mail, use your calendar for personal and group scheduling, and do some
advanced task management. In addition, you have access to your contact
information and a journal-like notebook. iNotes Web Access also has a
customizable Welcome page.

This IBM Redbook offers you information on how to best install, deploy, and
configure iNotes Web Access for your environment. It describes how to make
your installation secure, keeping unwanted visitors outside of your iNotes Web
Access installation yet allowing your users to access their mail files from outside
the corporate firewall.

If your organization uses Notes clients to access mail and other services of
Domino, you will still find iNotes Web Access useful. A scenario where these
clients coexist is explained, and upgrading to such an environment is described
in detail.

All the functionality of iNotes Web Access is available for you online as well as
offline. How to enable offline access to iNotes Web Access with Domino Off-Line
Services is presented.

This redbook gives you details for capacity planning so you can size your
environment correctly and describes how to get the best performance out of your
servers. It also gives you information on how to integrate Lotus Sametime into
your iNotes Web Access environment.

We describe the architecture of iNotes Web Access and, finally, offer some
examples of how to make modifications to iNotes Web Access.

This redbook is written for network or Domino administrators deploying iNotes
Web Access. We assume that you are throughly familiar with administering a
Domino server.

© Copyright IBM Corp. 2001 vii
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Introduction

The selection of the mail client is not an ultimate selection, excluding the use of
other clients. Often, the same user can use different clients in different situations.
This could depend on various factors. For example, how is the user accessing
the mail, or what kind of task is the user trying to do? The user could be
accessing the mail from his or her own workstation in the office, from the home
PC, from a PC in an Internet Cafe, from a PDA, or from a smart phone. There
could be a different client selection for each of these situations.

In this chapter we introduce you to iNotes Web Access and other products
related to it. We discuss the different clients available to access Domino services.
We briefly describe some of the clients, and provide information that you can use
to determine which clients best suit the needs of your users.

© Copyright IBM Corp. 2001 1



1.1 What is iNotes

iNotes is the name for a family of products that provide Domino messaging,
collaboration, and e-business capabilities to Web browser and Microsoft Outlook
users. The iNotes family consists of three products:

» iNotes Web Access
» iNotes Access for Microsoft Outlook
» Lotus iNotes Sync Manager

1.2 What is iNotes Web Access

2

iNotes Web Access is a Web client that allows users to access different Domino
services using the Web browser. iNotes Web Access provides the browser user
with access to a number of features that were previously only available for users
with non-browser clients, such as Lotus Notes. These features are in the areas of
messaging, calendar and scheduling, personal information management (PIM),
task management, and personal journal. Users can also work offline to manage
e-mail messages, contacts, calendars, to-do items, and so forth, from the user
interface that iNotes Web Access provides.

iNotes Web Access can be used independently, or together with the Lotus Notes
client. Users can use the Notes client while they are in their office environment,
and use iNotes Web Access while they are remote and their only choice is to use
a Web browser—such as when they are in an Internet Cafe, at another user’s
PC, or on their home PC.

Although they are using different clients in different situations, users are still
using the same mail file and the information is always up-to-date.

For administrators, iNotes Web Access provides a simple client that is easy and
cost-effective to manage and deploy. This is all done from within the same
Domino infrastructure that they already manage. The thin-client and
server-based deployment model imposes no training requirements, and allows
companies to get users up and running quickly.

You might have a Domino installation in your organization and your users have
been using Notes clients to access Domino services for some time. So, what’s
the big difference with iNotes Web Access compared to earlier releases of the
Domino server?

iNotes Web Access Deployment and Administration



What has been added and what has been changed? What do |, as a Domino
administrator, have to do? These are some of the questions this book is intended
to answer.

There are some important things to note when you are planning to let your users
access their mail files with a browser. It is critical that you keep unwanted users
out of your network, even as you enable your users to access their mail from the
outside. Chapter 2, “Security” on page 9 describes how to secure your
installation.

Starting with Domino release 5.0.8, iNotes Web Access is shipped with the
Domino server. iNotes Web Access uses mostly files that reside on a server. In
addition to a Web browser, only a few things have to be installed on the user’s
workstation if the user will need to access their mail files offline. In case other
files are needed locally, they are loaded from the server. Files related to iNotes
Web Access on the server are:

» iNotes5.ntf, which is the actual template used to create or upgrade mail files
for users

» Forms5.nsf, which contains most of the elements used to build the iNotes
Web Access user interface

For details on the purpose and content of these files, see 6.2, “Template
architecture” on page 117.

1.3 Selecting the best client

A wide range of clients is available to access services provided by a Domino
server. To help you determine when to use which client, we briefly explain the
following clients:

» Lotus Notes
» iNotes Web Access

» iNotes Access for Outlook

» WebMalil

» Mobile Notes

The selection of the client is based on the situation you are in rather than what
the specific features of a certain client are.

An iNotes Web Access feature comparison article on Notes.Net contains a table
comparing features between iNotes Web Access, WebMail, and Lotus Notes
clients. An updated copy of the table is in Appendix A, “iNotes Web Access
feature comparison” on page 139.

Chapter 1. Introduction 3



1.3.1 Lotus Notes

4

Lotus Notes is an integrated e-mail and e-business software solution for the
Internet and corporate intranets. Notes integrates information sources, including
e-mail, calendaring, group scheduling, to-do lists, and more. Notes users can
exchange messages via the Internet, work with any Web application, read and
post topics to Internet newsgroups, search Web directories, and use X.509
certificates for security. Notes users have access to their e-mail and other
applications while they are offline, giving them the option to synchronize their
work later.

Integration with the Lotus Domino R5 Server makes Notes R5 available as an
e-business client, with high functionality, security and customization options.
There are built-in collaborative applications, like discussions and document
libraries, as well as third-party Domino-based e-business solutions.

When to use Lotus Notes client

If your users need more than just a mail client—but a client to integrate mail,
calendar, address book, and to-do lists into workflow, Web, and e-business
applications—the client to use is Lotus Notes client.

£ ITSO iNotes - Inbox - Lotus Notes [_|Ofx
File Edit Yiew Create Actions Help @ ;> &} -‘; \a\ G

@W’elcome @ITSO iMotes - Inbaox X noftes
g Mail New bemo @' Reply @ Fanward 0 Delete @ Falder @ Copy into e Tools

A| Date Subject
iMates User 21.08.2001 1780 Fe: iMotes Web Access Redbook
! 2T * Jakke Vilee 30102007 B4 A marketing presentation about iMotes Web Access
- TS0 Motes 30.10.2001 ESZ  You presentation
el @ All Documents
T Trash
= Discussion Threads

DCrafts

Rules

Stationery

BUPE BOP

“|=2| Dtfice k=

Figure 1-1 A mail inbox in the Lotus Notes cient
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1.3.2 iNotes Web Access

iNotes Web Access combines Domino messaging, collaboration, and e-business
capabilities and provides them to users using Web browsers. iNotes provides
centralized management and deployment and a no-touch installation to the
user’s desktop.

It delivers messaging, collaboration, and PIM functions to Web browsers through
an easy-to-use user interface, both online and offline.

When to use iNotes Web Access client

You might want to choose iNotes Web Access for your client in a situation where
you’re upgrading from a traditional mail system to Web browser-based mail, or
when you are installing your first mail system.

Consider using iNotes Web Access if your users don’t have a designated
workstation, or if they have to be able to access their mail files from computers
with only a Web browser installed, or from outside the network of your
organization.

iNotes Web Access is a wise choice also for organizations using Lotus Notes
mail. It does not have to be an exclusive choice between Lotus Notes or iNotes
Web Access since you can use both to access your mail file in different
situations.

If your organization has Domino WebMail users, you might want to provide them
with better functionality by upgrading to iNotes Web Access.

Chapter 1. Introduction 5



/] welcome - Microsoft Internet Explorer H=]E3
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Address IQ http:f1127.0.0.1 mailfinotes . nsf fikotes Welcome *OpenDocument &L ogin&ui=inotes :J &0

o W Logout W Go Offline W Preferances o Help =
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ITS0 iNotes { wWelcome Mail -~ Calendar - To Do List -~ Contacts -+ Notebook -
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30 ocz0, 2001 Welcome I B
02:55PM

L

Mew ~ | Edit Layout...

4 2001 | New Mail
1 October [3 Who Date ~ Size Subject
S M T W T F 5| Jakke viilee i0fz0/2001 £54 A marketing presentation about iNotes Web :J
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|@] Done ’_ ’_ ’_ |4 Internet )

Figure 1-2 A mail inbox in iNotes Web Access client

1.3.3 iNotes Access for Microsoft Outlook

6

iNotes Access for Microsoft Outlook brings reliable, scalable Domino Messaging
to Microsoft Outlook 98/2000 users.

The Microsoft Outlook user experience is unchanged with iNotes Access for
Microsoft Outlook; users simply work with their mail, calendar, and task data on
Domino instead of Microsoft Exchange. Familiar Microsoft Outlook features are
supported, including rich text, folders, and integration with Microsoft Office
applications.

iNotes Access for Microsoft Outlook also gives Microsoft Outlook users the
additional benefits of Domino Messaging features not available with Exchange,
including full text search capability for their mailbox, superior mobile capabilities,
and native support for Internet standards (SMTP/MIME and HTML).

You connect Microsoft Outlook 98/2000 users to Domino by completing one
simple form. Users connect to their new Domino Server with just three mouse
clicks.
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When to use the iNotes Access for Microsoft Outlook client

Choose the iNotes Access for Microsoft Outlook client if you want to improve the
reliability and scalability of your messaging infrastructure, add e-collaboration,
and upgrade from Microsoft Exchange to Domino, all without having to change
clients.

1.3.4 Domino WebMail

The initial goals for Domino WebMail were to give users the ability to access their
Notes mail files with a browser and to provide a better user interface.

When to use Domino WebMail

Domino WebMail would still be a valid option for users who use platforms such as
UNIX, Linux, or OS/2, or if your organization is using browsers other than Internet
Explorer, such as Netscape Navigator. If you are planning to roll out Domino
WebMail because your organization is using Netscape Navigator as the browser
client, you might want to wait for the Rnext release (the next major release of
Lotus Domino). Support for the Netscape Navigator 4.7 client (on Win32
platforms) for iNotes Web Access is planned for the Rnext release of Lotus

Domino.
2} ITS0 iNotes - Microsoft Internet Explorer A=

File Edit Wiew Favorites Tools Help |Links @B\uaPagas @Cust @Wheather »|-
GBack - = - (D a3 | {Qsearch [EfFavorites  GliMedia L4 | ==

Address I@ http:ff127.0.0,1/mailfiinates. nsfPopendat abasetui=webmai j oo

& ewnermo (@ Folder €3 Delate 3 Tools (D Add Sender To Address B |

@ i Previous Page | Nexi Page | Firsi Page | Last Page — Select Folder— | Move io Folder Or Capy io Folder
oK e Lopy 1o Yolder
X Drafie

£ Gant INBOX VIEW

£ A duress Book Who «  Date v Size v Subject

A Daieanie [~ itfotes User 21082001 1730 Re:iotes Web Access Redbook

@ Trash [~ Jakke Viilee 30.10.2001 684 A marketing presentation about iNotes Web Aocess

E Discussion [~ ITE0 iotes 30.10.2001 692 Vour presentation

] Rules

Previous Page | Next Page | First Page | Lasi Page

® = =
@ [ [ et )
Figure 1-3 A mail file in the Domino WebMail client
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1.3.5 Mobile Notes

Mobile Notes with Domino Everyplace provides access to your Domino-based
applications from your favorite handheld devices, such as personal digital
assistants (PDAs) and WAP phones. Mobile Notes means anytime and
anywhere access to Notes and Domino through various means. You simply
decide what you need, choose the appropriate Domino Everyplace product, and
experience Mobile Notes on the device of your choice.

When to use Mobile Notes

Nowadays, many organizations have a lot of users with a constant need to
access their mail files and other Domino applications, regardless of the time and
place. While mobile, users can use handheld devices to access their Domino
applications using Mobile Notes. If your users need to access their mail files
using PDAs or WAP phones, it is recommended that you use the native clients of
these devices. For detailed instructions about accessing Domino servers with
various handheld devices, refer to the IBM Redbook Lotus Mobile and Wireless
Solutions, SG24-6525.

1.4 Domino Off-Line Services

For users who need to access their mail files while disconnected from the
network, Domino Off-Line Services (DOLS) is implemented on a server. Details
about installation can be found in 3.5, “iNotes Web Access client deployment” on
page 59.

DOLS enables users to work with their mail files offline, as they would with any
other Domino Web application. Users can read, create, modify, and delete
documents offline, and then synchronize the changes with the application on a
server. This is similar to what users have been able to do offline with Notes
clients.

1.4.1 Lotus iNotes Sync Manager

Lotus iNotes Sync Manager is installed on the user’s workstation when the user
goes offline for the first time, or it can be installed from an installation CD. With
Lotus iNotes Sync Manager, the user is able to set various options for
synchronization, such as a schedule.

8 iNotes Web Access Deployment and Administration



Security

Lotus has always set a high value on the security for Notes and Domino. The
same security architecture applies to iNotes Web Access as to all Domino
applications designed for the Web. Additionally, there are some security features
developed specifically for iNotes Web Access; they are described in this chapter.

We discuss the security features of iNotes Web Access in general, as well as the
things you should consider before you allow access to your server with a Web
browser. We offer ideas for configuring the Internet Explorer and security settings
on your Domino server.

© Copyright IBM Corp. 2001 9



2.1 Authentication

To access their mail files, users must first authenticate with the Domino server.
The most commonly used authentication option, basic name-and-password
authentication, requires a person record in the Domino Directory or secondary
directory, configured by means of Directory Assistance, containing the user’s
name and an Internet password.

Figure 2-1 shows a person record in a Domino Directory.

£ Person record for: ITSO iNotes,/Demo - Lotus Notes [_ O]

File Edit Wiew Create Actions Text Help \J& / M\/ B \J\ G
{TE? o |

:';3 Welcome i TT's Address Book - People | u Person record for: [TSO iMo... i‘ notes

'Fg Save and Cloze @ Examine Intemet Certificatez) @ Examine Motes Certificate(s)

|

PERSON: ITSO'INeteg/Demo 150 iNotes/Demo @ TT |

Bazics l T l Waork/Home l Other] Mizcellaneous l Certificates | Administration

A

First namme: SIS0,

Middle initial: b

Last narne: TiMotes

User name: TITS0 iNates/Demo
IT50 iMotes

Alternate narne:

Short name/U serlD: ’JinotesJ

Personal title: " =

Generational qualifier. "™ =1

Internet passwond: T [ACE40F 752541 85FC43AD0E 361 CBOED
g

=l
First nare(s) and nicknames - e.g. John; Johnmy

A| g = ‘|'#_3Ifoice ‘iﬁAl

D8F mEpe

Figure 2-1 A person record in a Domino Directory

How users are authenticated against a Domino server is set in the server
document. There are three options to choose from: disabled (Basic
authentication), single server, or multi-server. (Single server and multi-server are
both session-based authentication schemes.) These three methods are
described in the next two sections.

2.1.1 Basic authentication

Basic authentication is the default setting for authentication. If you open your mail
file with a browser, you should see a dialog box similar to the one in Figure 2-2.
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Enter Network Password [ 2]

? Fleaze type pour uzer name and password.

Site: caffreys. lotus.com

Fiealm fmail

User Mame ||

Password I

™ Save this password in your password list

ok I Cancel

Figure 2-2 Browser login dialog box

We recommend that users do not select the check box “Save this password in
your password list” on their browser. If this box is checked, the password is saved
on the workstation, and unauthorized users could access this mail file later since
both the username and the password would be pre-filled.

Depending on where the database resides and on the authentication settings of
the server's Internet ports, you might have to log in again when accessing
another database not in the same directory. For example:

Open an iNotes Web Access mail file with a URL:

http://yourserver/mail/filename.nsf

The browser keeps track of user credentials based on the realm that the Domino
server sends to the browser. A realm is a string, which is typically a URL path,
that the server sends to indicate the location, or path, for which the user has
been authenticated. In this case the top-level realm would be yourserver/mail. If
you open another database which resides in another directory, for example
yourserver/help/help5_client.nsf, you will be prompted to authenticate again
since yourserver/help is not a subdirectory of yourserver/mail.

To avoid users being prompted to authenticate multiple times, you can enable

session-based authentication.

2.1.2 Session-based authentication

Session-based authentication allows users to authenticate once against either a
single Domino server or several other servers.
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With session-based authentication turned on, it is possible for a user to log out
without closing their Web browser. Session-based authentication also enables
customization of the login prompt and configuration of session time-outs for
users. For more information on configuring the Domino server for Web
authentication, refer to the Domino 5 Administration Help database
(help5_admin.nsf) and the appropriate Release Notes database.

To set the authentication option, open the server document and select Internet
Protocols -> Domino Web Engine. The “Session authentication” field includes
a pull-down list from which you can choose Multi-server, Single Server, or
Disabled, as shown in Figure 2-3.

™ Server: ZRH1/5RY/INOTES - Lotus Notes =10 x|
File Edit View Create Actions Text Help
Gdd g gpr P essgunitQ 0B

Workspace <LJiNotes Damino Directory-8s... | |_] Sewver: ZRH1SRWINOTES X notes

Fl(xSave and Close Q Wb,

SERVER: ZRH1/SRY/INOTES s ¥ . -
. -
Basics l Security l Ports l Server Tasks ] Inter  Kepwords ,L;
bulti-zerver
: . Single 5
HTTP l Domino Web Engine l NoP l LDAP Dlir;g;e‘jerver Cancel |
Session authentication: " Disabled ;=1
ldle session timeout: 730 minutes

M aximum active sessions:  © 1000

Does this server uze 1157 "Moo=l

Pratocol: hitp =
Host name: I g
Part number: "0

| A= ] |=2imsa <

Figure 2-3 Enable session authentication

Note: To use session authentication, Web users must use a browser that
supports cookies since Domino uses cookies to track user sessions.

After session authentication has been enabled, users have to log on using a form
instead of a dialog box. The users have to enter their username and password in
that form to authenticate. It is possible to customize this form; Figure 2-4 on
page 13 shows the default format.
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/2] Server Login - Microsoft Internet Explorer

File Edit view Favorites Tools  Help |Links @BluePages Les
GBack - = - 23 | Qigearch [Favorites ShMedia £ | 59
Address I@ http:f/127.0.0.1 mail{inctesma. nsf?OpenDatabasedd ogin j @GD
=
-
Server Login
Please enter your Username and Password
TTzername IUsername
Password |********
&
|_|_|_|Q Internst 4

|@ Dane

Figure 2-4 A session authentication form

We set up multi-server authentication in our environment. There was one
Sametime 2.5 server among the iNotes Web Access servers. Figure 2-5 on
page 14 shows how we implemented Sametime within the iNotes Web Access
Welcome page. As you can see, the user is already authenticated within

Sametime.
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/2§ vielcome - Microsoft Internet Explorer

J Fle Edt Wew Favorites Tooks Help
P P - 3 = = [
@« .+ @ B W8 = 3 B g H E
Back Forward Stop  Refrssh  Home | Search Favorites History | Mal  Print  Edif  Discuss
| Address [&] hitps:/eaffreys lotus.comfmalraim. nsf iNotes/Welcome{7CpenDocument =] e
. @logout @ Chat @ Gooffline @ Preferences @ Help 4
danrnino
Roger Zim " welcome Mail ~ Calendar - To Do List ~ Contacts - Notebook -
Lo Welcome

2 octoz, 2001
03:16PM
Mew + | Edit Layout...

Today's Schedule

4 Z001
B o | | who Date Size Subject 02:30PM Check Swissair Schedule
S M T w T F § Leonardo € Vidal 09/26/2001 937 test off-line o]
T 2 3 a4t s s
7 8 9 10 11 12 13
14 15 16 17 18 19 20
231.22°23°24.25° 326 27
28 29 30 31
=
Sametime
B it Sametime Tue, 10/2/2001 3:27 PM
Meeting Center Logged on as Roger Zim
New Meeting Active Meetings
® Active Mo meetings found
Scheduled
Finished
Today 55|
[ @ memet 7

&
Figure 2-5 Welcome page with Sametime

2.1.3 Authentication over Secure Sockets Layer (SSL)

If the users access their mail files from outside the corporate firewall, we strongly
recommended that you use SSL for the connection. SSL encrypts information,
such as the name and the password, sent over the network between client and
server. Without SSL, the name and password are transferred as plain text and
could be captured by anyone with a network sniffer or trace tool.

2.1.4 Name variations
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You can control how rigorously Domino authenticates Web users. On the
Security tab of the Server document, the setting "Web server authentication”
(Figure 2-6 on page 16) gives you two choices:

» More name variations with lower security: Domino tries to authenticate
users based on the name and password entered. This authentication method
can be vulnerable to hackers who attempt to access a server through a
legitimate user account by guessing names and passwords. This choice is the
default and is the Web server lookup behavior used in earlier releases of
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Domino (R4.6x). This option allows users to enter any of the following in the
name and password dialog box in a Web browser:

— Last name only, for example BulTlock

— First name only, for example Sandra

— Short name, for example sbullock

— Common name, for example Sandra Bullock

— Full hierarchical name, for example Sandra Bullock/Zurich/IBM
— Any alias in the User name field, for example sb

» Fewer name variations with higher security: This lookup technique is less
vulnerable to attacks because a single authentication attempt does not
produce as many matches, lessening the likelihood that a guessed password
matches. This choice is recommended for tighter security. It requires users to
enter only the following in the name and password dialog box in a Web
browser:

e Common name, for example Sandra Bullock
* Full hierarchical name, for example Sandra Bullock/Zurich/IBM
* Any alias in the User name field, for example sb.

Attention: Unlike with passwords for Notes IDs, there is no support to set a
minimum length for Internet passwords initially. iNotes Web Access requires a
password of at least eight characters if you change it from within iNotes Web
Access. However, it is possible to access iNotes Web Access with an initial
password of less than eight characters. The administrator should provide all
iNotes Web Access users with an initial password of at least eight characters
to avoid confusion.

See Lotus Knowledge Base, Document #186611, for additional information.
You can access the Lotus Knowledge Base from the Lotus Support Web site:

http://www.lotus.com/home.nsf/welcome/support

Figure 2-6 on page 16 shows where you select whether to use fewer or more
name variations for authentication.
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(™ Gerver: RI01/SRY/INDTES - Lotus Notes [_ (O]

File Edit View Create Actions Text Help ‘J‘ )’ «} 1@\ G

@ Welcame ‘) iMNotes Domino Directory - ServeriServers |U Server. RIOTISRVINOTES ﬂ‘ nofes

'i’-gSave and Clase 9 Wweh..
SERVER: RIOT/SRY/INOTES

o100 TUIEE
10101008

Basics l Securityl Ports I Server Tasks I Internet Protocals I MTAs l Miscellaneous | Tranzactional Logging l Administration |

Compare Motes public keys O Yes ® No ‘Web server authentication: ™ More name wariations with lower securityL_-_[
against those stored in
Directony:

Allows anonymaus Motes C Yes @ No
connections:

Check passwards on Motes L) Enabled ® Disabled

1Ds:

Only allow server accessta "y o Access this server "HPT AccessServer (v
vzerg listed in thiz Directory: 2= - o
Aocess server T = Raute through: THPT_RauteThru =]
Mot access server e | Cauze caling: " #PT_CauseCaling s =
Create new databases " #CreatehewDatabases | x| Destinations allowed: T aE

Create replica databases.  #CreateReplicas | =)
Allowed to use monitors: il seMonitors 4 =

Hot allowed to use monitors: * #NoManitars =]

Administer the server from a  © fhédminBrowser, Hadmin ;=]

browser: j

| 1 il i 1) |5
Figure 2-6 Web Server authentication field on the server document

2.1.5 Logout
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Many browsers store both logon credentials and private data in memory, typically
up to 30 pages, which is not reliably discarded until the browser is closed. iNotes
Web Access provides a “Logout” button (Figure 2-7 on page 17) that closes the
entire browser session, discarding the in-memory files and attempting to close
the browser window. This is to prevent anyone from accessing the user’s mail file
by clicking the back button, and viewing personal information from the previous
screen while their browser is open and unattended.

The browser remembers the user’s authentication information while it is still
open. When all browser windows are closed, cached files are removed from the
browser’s cache, so that no one can access the user’s personal iNotes Web
Access data. However, there are certain types of personal data that will not be
removed unless the user explicitly empties the temporary Internet files folder
through a menu command in the browser. For specific instructions, see 2.5.1,
“How to manually delete temporary Internet files” on page 30.
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Use the following steps to log out of iNotes Web Access:
1. Click the Logout button.

A} Mail - Microsoft Internet Explorer

J File Edt ‘“iew Favorites Tools  Help ‘ﬁ

J {EBack v = - @ @ 74 | @Search [He] Favorites @History | %v =]

J Links @ 1BM Standard Software Installer @IBM Business Transformation Homepage @IBM Internal Help Homepage

Jnddrass I@ http:,l’,l'itsokdss.Iotus.comp’ma\l,ilvidal.nsF,iiNDtes,l’MaiI,l'?OpenDocument&P}esetﬁoldts_\u'iawLabeljInbnx,s_ViawNama;°z’028°z’0241nb0><°fo:j @GU

@ L@nut @ Go Offine ) Preferences (@ Help =]

Leonardo C Widal

| — . '
- z 2 T server session and allow iNotes Web Access to close
Welcome Mail ~ Calendar - To Do List your browser window

Tuesday
2 octo2, 2001 Inbox I

02:132PM

-
b Who Date Size Subject Go to «*
e whass 09/10/2001 1473 tast -
inotes 09/18/2001 1193 “You are invited to join & QuickPlace: dbl

Sent db1 09/24/2001 1633 what's New in QuickPlace dbl
All Documents
Traszh
FolderA

=
|@ http: fiksokdsE. lotus . com/mailflvidal. nsFPLogout &R edirect To=(iNotes/FormsS.nsf fikotes IProwy PopenDocument&Form: l_ l_ Local intranet

e
Figure 2-7 The Logout button

2. iNotes Web Access displays a logout window. As shown in Figure 2-8 on

page 18 the window contains information about the logout procedure and
directions for the user to let the window close down.
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i File Edit View Favorites Tools  Help |ﬁ

_i =Back - = - B (2] &} | @isearch [GelFavorites CfHstory | B Sh

_i Links @ IBM Standard Software Installer @ IBM Business Transformation Homepage @ 1BM Internal Help Homepage

_i.ﬁ.ddress !@ http:,l’,l’itsokl:lsﬁ.Iotus.com,l’iNotes,l’FormsS.nsf,l'iNotes,l’Proxy,l’?OpenD0cument&F0rm=s_Logout&CacheResuIts&TimeSt-;! ¥ Go

-

7" iNotesWebAccess.

—_—

To prevent subsequent unauthorized access to your mail file, please allow the browser window to
close, also close any other iNotes related windows you might have open,

If you are accessing the server using basic authentication, the browser window remembers your
authentication information. If you do not close this window, future attempts to access your mail
server from this browser window will use the authentication information you previously entered.

If you do not let iNotes close your browser window for you, please close the browser window on
YOUr own,

- I
4 | E
|@ Dane l_ l_ Local intranet S

Figure 2-8 Logout screen

3. Finally, the user is asked to confirm closing of the window.

Microsoft Internet Explorer
/'ES The Web page you are viewing is trying ta close the window,
H

Do you want to close this window?

Yes Mo I

Figure 2-9 Logout confirmation dialog

Attention: Make sure that you close all browser windows. iNotes Web Access
secure logout will close the active browser window, but not necessarily all
browser windows.

2.2 Enabling Secure Sockets Layer (SSL)

There are two options to enable Domino databases for SSL connections:
» Enable SSL for all databases in the server document in the Domino directory.
» Selectively enable SSL on databases in the database properties.
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2.2.1 Enable SSL for all databases on the server

1. Open the server’s entry in the Domino directory. Select Ports -> Internet
Ports -> Web.

2. Change TCP/IP port status to Redirected to SSL.

TCPAP port number; Tan
TCPAR port status: " Redirect to 55L =]
Authentication options:
MHame & paszword: ez =]
Anonymous; "Mo =]
S5L port number; T 443 4
S5L port status: " Enabled =1
Authentication options:
Client certficate: "Mooy =]
Mame & pazzword: ez =]
Anonyrmous; "Moo =]

Figure 2-10 Enable SSL for all databases

2.2.2 Selectively enable SSL on databases

1. Select File -> Database ->Properties.

2. From the Basics tab, choose Web access: Require SSL connection
(Figure 2-11).

Database v LT 4 [
cililal&elslala
Title  Foger Zin

Server ZRHT/SRV/IMOTES

Filename  mail\rzitn.nsf

Type  Standard -
Archive Settings. . Encryption Settings. .
Settings
Replication Settings. .. Replication Histary. ..

Dizable background agents for this databaze
v adllow uge of stored forms in this database

Dizplay images after loading
¥ Wweb access: Use JavaScript when generating pages
[vw 8ehaccess Hequie S50 conhection: %

Figure 2-11 Enable SSL for a database
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For more information on how to set up SSL on a Domino Server, refer to the IBM
Redbook, Lotus Notes and Domino R5 Security Infrastructure Revealed,
SG24-5341, or see the document “Setting up SSL for Domino Servers,” which is
in the Domino 5 Administration Help database (help5_admin.nsf).

2.3 iNotes Web Access and access control

iNotes Web Access is a Domino Web application, and access to iNotes Web
Access is controlled by the administrator’s configuration of the Domino security
features and by the access control lists (ACLs) of the databases that are part of
the iNotes Web Access application. The minimum level of access required for
most functionality, including the ability to delegate mail and calendar entries, is
Editor.

Access levels, assigned to users in a database ACL, control which tasks users
can perform in the database. Access level privileges enhance or restrict the
access level assigned to each name, which can be an individual user or a group,
in the ACL. Access levels assigned to servers in a database ACL control what
information within a database the server can replicate.

2.3.1 Anonymous access
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When you set up Anonymous access in a database ACL, Web browser users can
access servers without identifying themselves. Domino does not record these
users’ database activities (meaning no entry is made in the Log file or in the User
Activity log of the database).

ACLs of databases don’t necessarily have the Anonymous entry by default.
When deploying iNotes Web Access, we recommend that you always add an
Anonymous entry, with No Access assigned to it, to the ACL for all mail files. This
will prevent users from accessing other users’ mail files.

Note: If there is no Anonymous entry in the ACL of the database, a user has
the access level that is assigned to the Default entry.

Table 2-1 on page 21 shows individual access levels assigned to different ACL
entries for the iNotes Web Access mail we used in this redbook. Both the Default
and Anonymous entries were set to No Access to prevent other users, whether
authenticated or not, from accessing the mail file. #Admin is a person group,
containing administrators of your Domino/iNotes Web Access environment.
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Table 2-1 Access levels for an iNotes Web Access mail file ACL

ACL Entry Access Level
-Default- No Access
#Admin Manager
Wolfgang Hass/USR/INOTESMIG Editor
Anonymous No Access
LocalDomainServers Manager
OtherDomainServers Reader
STR1/SRV/INOTESMIG Manager

Figure 2-12 shows an example of an ACL with Anonymous entry set to No
Access and Read public documents selected. This option is selected to allow
other users to access the calendar information for this user.

hoccess Control List

People, Servers, Groups: ISth All 'l I ser tupe:

IUnspecified 'I

Diefault-

Hedmin

.-'l'-.r'll:lr'l_','I'|'|l:ll.l:5:
HEl LocalDomainServers
e HEl OtherDomainServers
&2 STR1/SRVANOTESMIG

Rename. ..

‘?ﬁ Add...

& “olfgang Hass/USRANOTESMIG

INu:u Accers "I

[7 | Create documents

Acoesy

[T Delete documents

[T Create personal agents

[™ | Create personal folders fvisws
[7 | Create shared foldersdviews

l'“ C: ol o
Createroimearitalaya agent

Read public documents

Remove

Advanced Full name: Anonymous

Lazt change: “Wollgang Hass on 10/02/2001
According to: iIMOTESMIG

(] I L})Eancel |

Help |

Figure 2-12 Example ACL for Anonymous: No Access, Read public documents

Chapter 2. Security

21




When users access an iNotes Web Access mail file with an ACL like the one in
Table 2-1 on page 21, using a Web browser, iNotes Web Access opens. To
access the mail, calendar, preferences, and other features, users have to click
Login, as shown in Figure 2-13. Then they have to enter their name and Internet
password to authenticate themselves.

2 Mail - Microsoft Internet Explorer

File Edt View Favarites Tools Help ‘Links @jBIUBPages @qust ’ijhaather ”iﬁ
s=Back r = - @ @ a1 | @Search (3] Favorites @Media ] ‘ =] g
Address I-g] http:ff127.0.0.1 fmailfinotesma, nsf{ Fopendat abasefwi=inotes Ll @‘DGD
o . Lagin Go Offline Draferances Help =]
?’ iNotesWebAccess. o e s L
iNotes Mail  mail - Galendar - To Do List -
Friday
12 octi1z zo01 Inbox I
03:15PM
af =-er |
Wwho Date + Size Subject
Inbox
Trash E
|&] Done }_}_!_|Q Internet 4

Figure 2-13 Login hotspot

2.3.2 Access levels to a user’s mail file
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It is most common to grant Manager access to the owner of the mail file while
they are using the Notes client. Since Domino R5, it is possible to reduce this to
Editor access during the registration process for new users.

Whatever settings have been chosen for the owner on the Basics tab within the
ACL, the access to a mail file using a browser normally is Editor. This is based on
the Maximum Internet name & password access in the Advanced ACL settings,
as shown in Figure 2-14 on page 23.
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Access Control List

Adminiztration Server:

= More
= Server ISTFWSFIWiNDTESMIG

=

Basics
IDD not modify Reader or duthor field: _:!
":'J e
% Thiz database's Access Control List will automatically be updated
when the Administration Process is run on the server chozen above.
Rolez See Help far more infarmation.

Log
Look Up User Types for Unspecified TEe
?ﬁ’ Preszing thiz button will perfarm an address book, look up for each
4 uzer it the Access Contral List whao iz listed az an 'Unzpecified’ uzer
Sl twpe, 1f the name is found, the approprate uzer type [e.q. Server,

Person, etc.] will be et in the ACL.

Lazst change: STR1 on 0941 7/2001 06:23:16 PM C I Hel
According to: NOTESMIG il =

o]

Figure 2-14  Setting Maximum Internet name & password to Editor

Table 2-2 shows what features are available when different access levels are
assigned to the user. The table shows that the user needs at least Designer
access to use all these features.

Table 2-2 Access levels to the user’s mail file

ACL access level Maximum Internet | Change Internet Out of Office
name & password | Password agent available?
available?
Editor Editor No No
Editor Designer No No
Designer Editor Yes No
Designer Designer Yes Yes

Note: The option Change Internet Password is only available to the owner of

the mail file!
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Minimum access level required to access mail file
The minimum access the owner of a mail file needs is Editor. Provided with this
access level, the user is able to change the delegation settings.

Access level required to use Out of Office agent

In order to activate the user’s Out of Office agent, the user’s access level to the
mail file must be raised to Designer.

With a lower level of access than this, a message box will indicate that the user
has insufficient access to perform this operation and will show the user’s current
access level (Figure 2-15).

Microsoft Internet Explorer

' “'ou have insufficient access to perform this operation.
* “'our current user access level is: Editar

OK

Figure 2-15 Insufficient access to use Out of Office agent

Access level required to change Internet password

Even with Reader access or less to the Domino directory, the user is able to
change their Internet password, but Designer access to the user's own mail file is
required.

Figure 2-16 on page 25 shows where you can change your Internet password.
Click Change to open a window where you can change the password.
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<} Preferences - Microsoft Internet Explorer

Mail Calendar Work Hours Delegation Archive DatefTime Other
Search

" Enable full-text indexing for searching

Personal categories

[Type here to add a new categary]
Business

Personal

Friends

Family

Change Internet Password

Change”.tl

W

=

Figure 2-16 Change Internet Password section on the Preferences tab

Type the old password first, then the new password, and finally the new password
again to confirm the change.

/3 Change Password - Microsoft Internet Explorer

Type old password |"°‘°‘°‘°‘°‘°‘°“‘“‘
Type new password |”°’°‘°‘°‘°“‘“““““°"‘“°‘°“
Type new password again |‘°‘°‘°‘°‘°‘°‘°‘°‘°‘“‘“‘“““1

Figure 2-17 Change Internet password window

Note: If you do not see a Change button in the Change Internet Password
section of the Preferences dialog, even though access levels are set correctly,
this feature may have been turned off. See 3.3, “Server configurations” on
page 44 for details about how to enable and disable this feature.
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Minimum access for Delegation
In order to change any settings on the Delegation tab, shown in Figure 2-18,

Editor access to the user’'s own mail file is required. This works according to the
behavior of a regular Notes client, where ACL settings are specified by the mail
file’s Administration server.

; Preferences - Microsoft Internet Explorer

Mail | Calendar | ¥Wark Hours | Delegation | Archive | DatedTime | Cther |
Allow the following people to ...

Read mail, calendar, to do, contact, and journal entries
|Sandra Bullock

Read mail, calendar, to do, contact, and journal entries and send mail on my behalf

Read, send, and edit mail; Read and edit calendar, to do, contact, and journal entries;
Delete calendar and to do entries

Delete draft mail composed by delegates

Calendar Read Access

=

=

L

L

& anyone can read my calendar

" allaw only the fallowing people ta read my calendar

Calendar Author and Editor Access
" anyone can create and edit entries in my calendar

& pllaw only the fallowing people ta create and edit entries in my calendar
Sandra Bullock Ll

The respective delegate needs to have Author access to the mail file to create
calendar entries on behalf of the mail file owner.

= E:

Ir

I4

Figure 2-18 Delegation tab on Preferences
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2.3.3 Access level to the Formsb5.nsf database

The Forms5.nsf database is one of the databases included as part of iNotes Web
Access. It contains most of the JavaScript, pass-thru HTML, and images used to
implement the user interface of iNotes Web Access.

In order for iNotes Web Access to function correctly, make sure that Anonymous
is assigned with Reader access to the database {server’s data
directoryN\iNotes\Forms5.nsf. You will not see an entry for this database in the
Catalog.nsf database, but you can find the database by clicking the Domino
Administrator -> Files tab or by creating a bookmark in your Notes bookmarks
folder.

2.4 Database encryption

Database encryption provides an additional layer of security because ACL
settings do not protect locally stored databases.

2.4.1 Encrypting databases on the server

The use of local encryption of all databases on the server may further reduce the
risk of confidential information on Domino servers being accessed from outside a
corporate firewall. This requires the server ID file to be protected with a
password. In most environments where servers are physically secured, this may
not be a necessary measure. However, it is a valid option.

To encrypt a database:
1. You must have Manager access in the database ACL.

2. Select the database icon from your bookmarks page, and select File ->
Database -> Properties (see Figure 2-19 on page 28).
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Database - w2 X |

il lG|l&]l 21 |l=
AR otes Doming Directory

Server RIOT/SRVANOTES

Filename  names.nsf

Tupe Address Book -
Archive Seftings... Enciyption Settings... [
Seltings -
Feplication Settings... Replication Histday...

Dizable background agents for this database

v Allow use of stored forms in this database
Dizplay images after loading

v Web access: Use JavaScript when generating pages
‘Web access: Require 551 connection

Figure 2-19 Database Encryption settings

3. Click the Database Information tab, then Encryption.

4. Choose Locally encrypt this database using: (see Figure 2-20) and then
choose an encryption level:

— Simple
— Medium (default)
— Strong
Encryption for iNotes Domino Directory
£ Do not locally encrupt this databaze
% Locally encrypt this database using: | Medium Encryption - Cancel |

For: RIOTASRVANOTES

Thiz databaze will not be able to be opened locally without the appropriate user 0.

Medium encryption iz the recommended choice. |t offers good security and speedy access to
documents. Databaszes using medium encryption cannat be compressed by disk compression
utilities.

Figure 2-20 Encryption options
5. If the database resides on the server, it will be encrypted using the server’s

Public Key. Otherwise, click For and choose the appropriate user ID to
encrypt the database.
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2.4.2 Encrypting a mail file on a workstation

With Domino R5.09 or later it is possible to encrypt mail on the workstation

locally. Users can select simple, medium, or offline encryption for the offline mail
file.

To encrypt the mail file, select Encrypt mail file locally on the Other tab of

Preferences, as shown in the Figure 2-21. Select the level of the encryption. The
mail file is encrypted locally next time you synchronize your local mail file.

; Preferences - Microsoft Internet Explorer [ [Ofx

Ir

Mail | Calendar | Work Hours | Delegation | Archive | DatefTime } Other |

Search

I” Enable full-text indexing for searching

Personal categories

[Type here to add a new category]
Business

Persanal

Friends

Family

Change Internet Password

Change... |

Offline

¥ Compact mail file after sync

¥ Update full text index after sync
¥ Encrypt mail file locally

 Simple encryption

& Medium encryption

 Strang encryption

I4

Figure 2-21 Encrypting a mail file locally

Note: If you do not see the Encrypt mail file locally option in the offline section,
this feature may have been turned off. See 3.3, “Server configurations” on
page 44 for details about how to enable and disable this feature.
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2.5 Security issues for users on kiosk or Internet cafe

iNotes Web Access lets you easily access your Notes mail, calendar, contacts,
to-do list, and notebook directly from anywhere, such as at a kiosk or Internet
cafe, or at home.

As described in 2.1.5, “Logout” on page 16, the logout function on iNotes Web
Access sends a logout command to the server to end a session, if session
authentication is being used. iNotes Web Access also closes the browser
window to prevent another user from hitting the Back button to view personal
information from the previous screen. In addition to secure logout, iNotes Web
Access does some sophisticated things with caching algorithms. This is to
prevent the storage of information in the local browser cache in a format that
someone could easily view.

It should be noted that the secure logout function does not clear the browser’s
local cache. Because Internet Explorer stores content in the browser’s cache, it is
possible to access that information programmatically. iNotes Web Access is
unable to delete those files for users, therefore they must do it by themselves as
shown in Figure 2-22 on page 31, or configure the browser to prevent the local
storage of information (Temporary Internet files) after the session has
terminated, as shown in Figure 2-24 on page 32.

2.5.1 How to manually delete temporary Internet files
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1. On Internet Explorer 5.01 or above, select Tools -> Internet Options.
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Internet Options ﬂ

General | Security | Conkent I Conneckions I Prograrms | Advanced I

—Home page

E§ ‘fou can change which page to use For your home page.

Address:

Use Current Use Default Use Blank

—Temporary Internet files
I Pages vou view on the Internat are stored in a special Folder
& §

For quick viewing later,
DeleteEiIesg Setkings...
|
—Histary:

. The History Folder contains links to pages you've visited, for
quick access to recently viewed pages,

Davs to keep pages in history: I 20 3: Clear Hiskory |

Colors, .. I Fonts. .. I Languages...l P.ccgssibility...l

oK I Cancel I Apply I

Figure 2-22 Internet Options window

2. Click on Delete Files.

Delete Files E
& Delete all files in the Temporary Internet Files

‘¥ou can also delete all wour offline conkent stored
lacall.

IV Delete all offiine content

oK Cancel |

b
Figure 2-23 Delete Temporary Internet Files confirmation window

3. Click OK to confirm the deletion (Figure 2-23 on page 31).

2.5.2 Deleting temporary Internet files automatically

There is an option to configure Internet Explorer to empty temporary Internet files
automatically. This can be enabled on Internet Explorer 5.01 or above by
choosing Tools -> Internet Options -> Advanced tab (see Figure 2-24 on
page 32). Check the option “Empty temporary Internet file folders when browser
is closed”.
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Internet Options ﬂ
General I Security | Conkent I Conneckions I Programs Advanced |

Settings:

O Just display the results in the main windaw _:_l
O Just go ko the mast likely site
é Security
O check For publisher's certificate revocation
O check For server certificate revacation (requires restart)
O Da nat save encrypted pages to disk

Empty Temporary Internet Files Folder when brow
k nable Profile Assistant

Use Fortezza

Use PCT 1.0

Use S5L.2.0

Use S5L 3.0

UseTLS 1.0

‘Warn about invalid site certificates

O warn if changing between secure and not secure mode

| Warn if forms submittal is being redirected | hd

4 3

Restore Defaults |
oK I Cancel I Apply I

Figure 2-24 Empty temporary Internet file folders when browser is closed

2.6 Differences between iNotes Web Access and Notes
security

Most of the security features that the Notes client user has are also available to
the iNotes Web Access user. However, there are also some features that are
implemented differently.

2.6.1 Protection against malicious code

In the Notes client, an Execution Control List (ECL) is used to protect data on a
user’s workstation. With ECL you can limit what can be done by formulas and
scripts on the user’s workstation. For example, with correctly set ECL, you can
prevent the use of code to access the file system, other Domino databases, and
external code. For more information on ECLs, see the document “The
workstation ECL,” which is on the Domino 5 Administration Help database
(help5_admin.nsf).
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It is possible to write code that could do damage on a user’s workstation and to
attach that code to a mail message. Due to the nature of the Web client, there is
no ECL available to protect a user's machine against malicious code. Instead
there is an iNotes Web Access active content filter, which removes potentially
malicious active content from the mail message before the message is delivered
to the user. This filter will protect against the most common attacks. It is not
designed to protect against viruses or other hostile code inside attachments.

Tip: Providing a user's machine with a personal firewall could also be a useful
step to improve security

2.6.2 Authentication method

When users access a Domino server with a Notes client, they are using Notes ID
files for authentication. There is no ID file available when accessing a Domino
Web application, such as iNotes Web Access, with a Web browser. Users
authenticate against the Domino server with name and password only. However,
there are several techniques available to increase security, as described in 2.1,
“Authentication” on page 10. In addition, it should be possible to use X.509
certificates to authenticate Web browser users accessing a Domino Server.
Refer to the IBM Redbook, Lotus Notes and Domino R5 Security Infrastructure
Revealed (SG24-5341), for information on how to create and distribute X.509
certificates.

2.7 Reverse proxies

A proxy server filters the requests of internal clients to one or more servers on
the Internet (Figure 2-25 on page 34). Only the proxy server is known to the
outside world. The architecture of the proxy delivers the information to the
requesting client.
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Figure 2-25 Proxy server

A reverse proxy is based on the idea of the proxy (Figure 2-26 on page 34). A
request to this Web server is delivered to the reverse proxy. The reverse proxy
resolves the requested URL, sends it to the appropriate server, and delivers the
information from the answering server to the inquiring Web browser. Therefore,
only the Web server containing the reverse proxy is known to the Internet.

-”;.L ;
= T Server

o
| — ]
(] R
R I
1 Lo N il [——]
—
g =
oy Reverse proxy
[ =] ="
iMaotes
Weh Access
Server

Figure 2-26 Reverse proxy

In some network environments, administrators deploy reverse proxy servers to
allow users to access other HTTP servers inside the firewall from the Internet.
Reverse proxy servers rewrite URLs within Web pages before returning the
pages to the user. The rewrites are intended to redirect all subsequent URLs
through the reverse proxy server. Some reverse proxies only rewrite URLs within

iNotes Web Access Deployment and Administration



non-JavaScript portions of the Web pages, while others rewrite full URL strings
found within JavaScript as well. In either case, any Web application that
programmatically builds URLs using JavaScript will need to design URLs in the
application to take this behavior into account.

iNotes Web Access has been engineered to work well with reverse proxy
servers. Each of them behaves in its own way and has to be set up accordingly.
Refer to the documentation of each product for installation and configuration
details.

iNotes Web Access was tested with following products:

» Sun iPlanet Web Proxy Server 2.0 sp2
» Tivoli SecureWay Policy Director 3.2
» IBM WebSphere Edge Server 1.0

2.8 Firewall issues

Refer to chapter 5 “Domino and Firewalls Revealed” in the redbook Lotus Notes
and Domino R5.0 Security Infrastructure Revealed SG24-5341, which gives you
a good review for the deployment of firewalls and their interaction with your
Domino infrastructure. For online access refer to:

http://www.ibm.com/redbooks
You have to open additional ports in order to maintain other services through

your firewall. Table 2-3 shows which ports have to be opened in your firewall for
the use of iNotes Web Access.

Table 2-3 Ports affected by iNotes Web Access

Service Needed for Port SSL Port
HTTP Web browser access 80 443
SMTP Incoming/outgoing mail | 25 465
NRPC DOLS replication 1352 | -

2.9 Client-side security

This section describes some client-side (browser) security considerations when
using iNotes Web Access.
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2.9.1 Cookies

Cookies are a method for sending session-based information from browser to
server. Cookies normally contain information about the user and/or user session.

To have iNotes Web Access work properly, the browser has to allow cookies.
iNotes Web Access uses one cookie, named Shimmer, where all application
settings are stored. This cookie is only retained in memory and never written to
the user's workstation.

2.9.2 Private data and browser cache
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iNotes Web Access makes a distinction between iNotes Web Access design
elements and personal data, with respect to the browser’s cache. In general, the
HTML in which personal data is generated is set, using the Cache-Control HTTP
response header, to a value of “no-cache,” which advises the browser that it
should not store the page in the browser’s file-system cache. Design elements
such as the JavaScript, .gif files, and blank forms of iNotes Web Access are
marked with a one-year expiration. This facilitates better performance for iNotes
Web Access when used over a dial-up connection, since the browser will not
attempt to download these design elements if they are already resident in the
browser’s cache (assuming the browser’s setting for “Empty temporary Internet
files when browser is closed” option is not set.)

One exception to this rule is that iNotes Web Access generates a .pdf file to print
the user’s Calendar. This .pdf file, containing user data, is marked “private” since
it must be present in the cache in order for Adobe to view it. This file is kept open
for up to one minute following the close of the Adobe Acrobat Reader. Moreover,
because of an issue with Internet Explorer (see article ID: Q272359 on
http://www.microsoft.com), iNotes Web Access sets Cache-Control to “none”
for XML data returned when SSL is in use. This means that view data is left in the
cache in this scenario. This XML data is the data used by views to show
information.

Note that many browsers store both logon credentials and private data in
memory; they are not reliably discarded until the browser is closed. For this
reason, iNotes Web Access provides a “Logout” button (Figure 2-7 on page 17)
to close your entire browser session and discard the in-memory files. Users can
also set their browser to delete all files from the Temporary Internet files folder
when the browser window is closed. This would delete any code and data that
may have been left in the cache. For specific instructions, see 2.5.1, “How to
manually delete temporary Internet files” on page 30.
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2.9.3 Encryption

iNotes Web Access does not currently support reading and sending encrypted
mail. When trying to read encrypted mail, you will see a message in place of the
body of the message that indicates the mail has been encrypted and must be
viewed using a Notes client. iNotes Web Access also provides a user preference
to set a “default copy and close” folder that will enable “one click” saving of mail
messages into a folder such as “read later with Notes” to allow users to more
effectively store these mail messages for subsequent review with the Notes
client.

2.10 An example of iNotes Web Access network
environment

Figure 2-27 on page 38 illustrates the iNotes Web Access network setup we
used as an example in preparing this redbook. The Domino network was split
into two separate Notes domains for the following purposes:

» iNotesMig domain

— To migrate an existing R4.67 environment into R5.08 iNotes Web access.
» iNotes domain

— To use iNotes Web Access with Domino Clustering.

— To build connectivity from iNotes Web Access to QuickPlace and
Sametime.

— To access the domain servers from the Internet. Our environment is
secured by firewalls and the access to iNotes Web Access is only given
through a reverse proxy server, which is on the demilitarized zone.
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Figure 2-27 iNotes Web Access network environment used in this redbook
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Deployment

This chapter discusses some of the factors you should consider when deploying
iNotes Web Access on your Domino server infrastructure. There are many
possible variations of Domino architecture, each of which has some unique
characteristics to consider. For example, many organizations may want to
leverage their prior investments with Notes clients and Domino servers for some
period while migrating their users over gradually, until the majority are using
iNotes Web Access. Other organizations may want to keep users accessing their
Notes clients in the office, and accessing their mail files using iNotes Web
Access either from home or from an Internet cafe.

This chapter provides important deployment guidelines that are useful regardless
of size, hardware, or operating system used.

This chapter covers the following topics:

Server and client requirements

Scenarios - running different mail clients on a single server
Server configurations

Migration of users

iNotes Web access client deployment

Uninstalling iNotes Web Access client

Directory Assistance and Directory Catalog

Welcome page

Server deployment: Quick reference

VVYyVYyVYVYVYVYYVYY

© Copyright IBM Corp. 2001 39



3.1 Server and client requirements

This section describes both client and server requirements for iNotes Web
Access deployment. These requirements and recommendations should be used
as general guidelines only.

3.1.1 Client requirements

Software
» Win32 Internet Explorer 5.01 Service Pack 1 or above.

» Adobe Acrobat Reader, version 4.0 or above. (This is used for calendar
printing.)

Operating system
» Windows 95, Windows 98, Windows NT 4.0 or Windows 2000

Hardware

Based on customer feedback, we recommend that you have at least a Pentium Il
400 MHz machine with 128 MB of memory in order to have reasonable
client-side performance.

3.1.2 Server requirements
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Software
» Lotus Domino 5.0.8 server or later

Operating system
» AlX4.3.3

» 0S/400

» 0S/390

» Solaris Sparc 7, 8

» Windows 2000 Professional, Server, Advanced Server
» Windows NT Server 4.0 Service Pack 4 and above
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Server memory requirements
Table 3-1 Memory requirements

Platform Minimum
Windows NT /2000 256 MB
UNIX 256 MB
iSeries 1GB
S/390 and zSeries 700 MB

Server disk space
» Minimum 750 MB, 1 GB or more recommended

» Windows 2000, 2 GB (with a minimum of 1 GB of free space)

3.2 Running different mail clients on a single server

Notes, WebMail, and iNotes Web Access are all based on the same physical mail
file, so the upgrade path is very simple. But there are several important
considerations to be aware of when deploying iNotes Web Access clients in a
mixed environment. In this section we describe different Notes environments,
and we provide deployment guidelines to help you avoid problems that could
prevent overall productivity during this migration period.

3.2.1 Deploying in a predominantly pre-5.0.8 environment

It is quite common that not all of the servers can be upgraded in a short period of
time. This could raise coexistence issues, where different versions of Domino
servers run in the same infrastructure, thus sharing the same directory, the same
system databases and database replicas. In general, Domino R5.x was designed
to work in a mixed environment.

You may choose to deploy just one or a small number of Domino servers with
iNotes Web Access in a server infrastructure where the majority of servers are
R4 and pre-5.0.8 servers, to accommodate a gradual migration to a 5.0.8 or
newer server. In this case, the administrators must be careful to recognize that
iNotes Web Access users will be using the new iNotes Web Access template
design, so template replication to earlier server releases should be prevented.
We recommend that you turn off design replication on mail file replicas on the
5.0.8 or newer servers. This is described in more detail in 3.4, “Migration of
users” on page 48.

Chapter 3. Deployment 41



3.2.2 Using Notes clients and iNotes Web Access on the same mail

file

Many organizations will want to deploy Notes and iNotes Web Access clients
against the same Domino server. Since iNotes Web Access requires the 5.0.8 or
newer server, this deployment scenario assumes that there may be Notes clients
and iNotes Web Access clients being configured against the same 5.0.8 or newer
server. Many of these client users may even switch between the Notes and
iNotes Web Access client against their own mail file. This mixed client
environment is fully supported by 5.0.8 because the iNotes Web Access template
is compatible with earlier releases of the Notes client.

When deploying into this type of mixed client environment and using the iNotes
Web Access template, Notes users will continue to see the standard Notes client
user interface to which they are used to. When switching to use the iNotes Web
Access client, they will see a new user interface of iNotes Web Access that
includes such elements as the Date navigator, Contacts, and Notepad. As is the
case with Notes template replication, unless someone specifically turns off
design replication, the iNotes Web Access template will replicate to any local mail
replicas on the user’s Notes workstation.

Any R5 Notes clients are supported to interoperate with an iNotes Web Access
user. It does not need to be a 5.0.8 or newer version of the Notes client to be able
to, for example, send e-mail to an iNotes Web Access user.

3.2.3 Using iNotes Web Access and Webmail in a mixed environment
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iNotes Web Access has more features and better performance than WebMail.
iNotes Web Access has approximately 90 percent of the most-requested
features that were not in WebMail—for example, unread marks, spell check,
out-of-office agent, unlimited attachment support, and more. And iNotes Web
Access performance targets are well above the performance levels of WebMail.

In the initial release of iNotes Web Access, WebMail will continue to exist, in part
because of the platform limitations initially with iNotes Web Access. The inclusion
of WebMail support ensures that users can access their Domino server no matter
what browser is on the device they are using. For example, if you attempt to
retrieve your mail from an airport kiosk, an Internet cafe, or a customer’s location,
you have no control over what browser type or version you will find on those
machines. If you use a browser that is unsupported by iNotes Web Access, the
Domino server will render the WebMail experience, rather than an error
message.
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There can be organizations that choose to have both iNotes Web Access and
WebMail deployed because of the platforms they are using. If at some point the
platform you are using is supported by iNotes Web Access, you can upgrade
your users easily by changing the template from which they are inheriting their
design.

Although this can be done, there are several important points to consider during
deployment planning:

» Consider the overall server bandwidth implications. Plan your user
deployment in line with the server’s scaling capabilities. You want to be sure
that CPU use is not maximized during the anticipated peak user periods so
that overall performance and response times remain acceptable.

» Inform your users that a user interface parameter setting (&ui=argument) is
available to easily switch between WebMail and the iNotes Web Access. The
first example shows how to open a user’s mail with the iNotes Web Access
user interface; the second example shows how to switch to a WebMail user
interface:

iNotes Web Access user interface:
http://www.acme.com/mail/jsmith.nsf?0penDatabase&ui=inotes
Domino WebMail user interface:
http://www.acme.com/mail/jsmith.nsf?0penDatabase&ui=webmail

Table 3-2 User interface parameter setting

Argument Description
inotes <default> Normal iNotes Web Access user interface
webmail Provides the user with the WebMail user interface. This state is

remembered on the server and if the server is set up for basic
authentication, it affects all future URLSs to this database from the
same client machine or any client machine.

Note: The selected user interface, WebMail or iNotes Web Access, is shown
until the user specifically selects the other user interface via the URL, as
shown in the examples. After this, the other user interfaces will be used.

Opening the mail file without the &ui= parameter will result in the user
interface being iNotes Web Access.
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3.3 Server configurations

This section describes settings and configurations required for iNotes Web
Access servers.

3.3.1 iNotes Web Access tab in server configuration document
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The configuration document in the R5.0.9 Domino Directory, as shown in
Figure 3-1, has a set of features available for iNotes Web Access. By default,
most of these features are available to the iNotes Web Access client unless you
take action to disable them.

/™ Configuration for Riol /SRY/INOTES - Lotus Motes

File Edit View Create Actions Text Help «,ﬂk / / WQ\ 0

Motes Domino Directony. . |u Configuration for... EI notes

@Welcome

T Save and Close

Basics | RouteSMTP | MIME | NOTESINI Setiings | iNotes Web Access | Administr

encryption setting:

Archiving on server % Enable
Full-text indexing: X Enable
M odification of Internet password: 8 Enable
Calendar printing: [X Enable
Custom Activei file attachment X Enable
uitiliby:

Alarms: X Enable
Alarm polling time: "5 | mintes
Minimum allowed mail poling ime: ™ 5 ; minutes
whelcome page URL: T2
welcome page title: T

Allow user to edit the welcome ¥ Enatle
page:

Walidate name and set alternate X Enable
riame items:

Allow uszer to configure altemate [ Enable
name dizplay sething:

Allows user to choose the preferred [ Enable
language:

Alternate name language: -"EnglishJ_vj
Encrept offing mail files: ™ Enable
Allaw uzer bo override afffine X Enable

=

Archiving creates a database on the serverwhere the mail file is located.

“|=2|RI01 “lEEy

Figure 3-1 iNotes Web Access Configuration settings

The Configuration document in the R5.0.9 Domino Directory contains the

settings defined in Table 3-3 on page 45.
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Table 3-3 Server configuration document: Settings in iNotes Web Access tab

Setting

Purpose

Archiving on server

Allows users to create archive databases on the server.

Full-text indexing

Allows users to create a full-text, searchable index of their
mail, to-do items, notebook, and contacts list. When
enabled, users have the possibility of creating an index.

Modification of Internet
password

Allows users to change their Internet password from
Preferences. When disabled, there is no password change
user interface in Preferences.

Calendar printing

Allows users to print calendar entries. When disabled, there
is no print button on Calendar view pages.

Custom ActiveX file
attachment utility

Allows you to use the custom file upload utility provided by
iNotes Web Access. This utility provides advanced features
such as drag and drop file attachment, easy file selection,
and multiple file views.

When disabled (the default), a DHTML implementation using
the standard File input element will be utilized.

Alarms

When disabled, no alarm will pop up.

Alarm polling time

Alarm monitor will check for alarms every XX minutes.

Minimum allowed mail
polling time

Check for new mail should occur no less than every XX
minutes.

Welcome Page URL

Any valid URL will override the existing Welcome Page.

Welcome Page title

If URL is valid, this title will be shown in the title area of the
Welcome Page.

Allow user to edit the
welcome page

Enabling this option allows users to edit the custom welcome
page.

Validate name and set
alternate name items

Alternate names provide the ability to represent a username
in a language preferable to the user.

Allow user to configure
alternate name display
setting

Allows users to turn on/off alternate name support and
choose the preferred language for an alternate name in the
preferences dialog.

Allow user to choose
the preferred language

Allows users to choose the preferred language for an
alternate name in the preference dialog.

Alternate name
language

This is a global setting that overrides any user setting for
alternate name language.
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Setting Purpose

Encrypt offline mail files | Offline encryption provides enhanced security. If you enable
this feature, you can select the level of encryption: simple,
medium, or strong.

Allow user to override Allows users to override the offline encryption setting
offline encryption through a checkbox in the iNotes Web Access preferences
setting dialog.

3.3.2 HTTP settings on the Internet tab

The Internet tab in the server document on Domino Directory contains HTTP
settings for Domino Web servers (see Figure 3-2 on page 47). See the Domino 5
Administration Help database (help5_admin.nsf) for details about each field in
the Server document.
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Figure 3-2 HTTP settings on the Internet tab

3.3.3 HTTP task

iNotes Web Access requires that the http task is running on the server. If your
server is not running it, you can edit the ServerTasks setting in the NOTES.INI file
to include the command http. It starts the Web server automatically when you
start Domino.
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Note: Domino adds the http task by default to the NOTES.INI file if you
choose to install a Web server during the Domino server installation.

Starting and stopping the Domino Web server
Table 3-4 shows different server console commands related to the http task.

Table 3-4 HTTP commands

To do this Perform this task

Start the Web server manually Enter 1oad http at the console

Stop the Web server Enter tell http quit at the console
Use new server configuration settings Enter tell http restart at the console
without stopping and restarting the http

server task.

3.3.4 Preparing a server for offline users

If you are planning to have offline users in your environment, some configurations
are required on the server. See 3.5.2, “Deploying iNotes Web Access for offline
users using DOLS” on page 60 for more information.

3.4 Migration of users

In this section we discuss two scenarios in which users who have been using
Notes clients are migrated to iNotes Web Access. Depending on the scenario,
users will either have Notes clients after migration or not.

3.4.1 Users using both clients after the migration

In this scenario users still have access to their Notes client after migration. The
Domino server that your organization is using for iNotes Web Access has to be
version 5.0.8 or later. If not, the first thing to do is to upgrade your Domino server
to a newer version.

Convert mail files to iNotes Web Access as described in 3.4.3, “Converting mail
files to iNotes Web Access” on page 58.

After the conversion, users’ malil files will have two additional actions available
from the Actions -> iNotes Web Access menu, as shown in Figure 3-3 on
page 49. These actions are used to synchronize Contacts and Journal between
the mail files and the respective databases.
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Figure 3-3 iNotes Web Access-related actions on the menu

Starting with Domino version 5.0.9, the action Synchronize Contacts also
synchronizes Person and Group documents between the Personal Address Book
and a user’s mail file. The iNotes Web Access user will be able to create and
manage personal groups, similar to the Notes client Personal Address Book.
These personal groups can be used for all mail, calendaring and scheduling
features.

3.4.2 Users using only iNotes Web Access after migration

In this scenario we migrate users who have been using Domino mail with their
Notes clients. After the migration these users will not have the Notes client
available.

The modifications and scripts described in this section are not part of the iNotes
Web Access product. Instead, we created them to enable this migration process.
You can find these modifications on the Redbooks Web site. Specific instructions
can be found in Appendix B, “Additional material” on page 151.

Documents that are currently stored in other databases have to be copied into
the mail file. This is because the user does not have the Notes client to access
these databases after the migration. Documents to be copied are:

» Business Cards (R4) / Contacts (R5) from Personal Address Book database
» Group documents from Personal Address Book database
» Journal Entry documents from the user’s Journal database
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In addition, the Notes ID file of the user is copied. This is done so users will have
offline access to their mail files via DOLS.

The Domino server that your organization is using for iNotes Web Access has to
be version 5.0.8 or later. If not, the first thing to do is to upgrade your Domino
server to a newer version.

These actions are performed via a mail message, which is sent to all users to be
migrated. All each user has to do is open this mail message; opening it activates
a script that copies the documents. The Notes client is needed to run the script.

As an administrator, you should perform the following steps to migrate the users.
The steps are listed here and then described in detail in the following sections.

1. Network mapping
2. Changes to the currently used mail file template (optional)
3. Create a malil file named iNotesConvert.
a. Create a MaillnDatabase document.
b. Create a new view: iNotesPrep\1. Sent.
c. Create a new view: iNotesPrep\2. Copied.
d. Create a subform: iNotesPreparation.
e. Incorporate the subform into Memo form.
4. Send out the preparation mail
5. Convert mail files to iNotes Mail and C&S

Networking mapping

In our scenario, we use drive M as temporary storage for the Notes ID. This has
to be unique to the user, otherwise the file could be overwritten. The folder could
be in the user’s home directory on a file server.

Changes to the mail file template

If your users are using Notes R4 mail files, change the SELECT formula for the
following views of your Domino server’s mail file template:

»  ($AI)
» ($Drafts)
» Discussion Threads.

Add

& !@isavailable(iNotesConvert)

to the end of the SELECT formula of each view, as shown in Figure 3-4 on
page 51.
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This is to hide Business Card, Contact, and Group documents from the user
since there is no form for showing them.

L All Documents - View - Lotus Notes

iw’ho A|Date v| |Suh|ecl
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| i
@ Define: |View Selection j|

Fur: O Easp ® Forrula

SELECT @AIICE @isavailable(iNotesConvert)

Fields & Functions. .. |

| 1 ] “[=0Sandra Bullock €57

Figure 3-4 View ($All) with a modified selection formula

Create a mail file named iNotesConvert

This file is used to send mail messages to the users to save their Notes ID file,
Personal Address Book, and to merge their documents into their mail file.

Perform the following steps:
1. Create a MaillnDatabase document

In order to receive status messages created by the script, as described in
“Sending out the preparation mail message” on page 58, you need to create a
Mail-in database document.
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Figure 3-5 MaillnDatabase document for iNotesConvert

2. Create a new view: iNotesPrep\1. Sent

This view shows all preparation mail messages sent to the users.

Selection formula for the view:
SELECT DeliveredDate = > & PostedDate != ““ & iNotesPrepSent = 1%

3. Create a new view: iNotesPrep\2. Copied
This view shows all status messages received from users who had opened

the preparation mail.

Selection formula for the view:

SELECT iNotesPrepDone = 1%

4. Create a subform: iNotesPreparation

We made all the modifications to a subform that we will insert into the

standard Memo form later.

The text field iNotesPrepSent, containing value “1”, is used for the view

'iNotesPrep\1. Sent'.
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Figure 3-6 Subform iNotesPreparation

As soon as the user opens the preparation mail message, the Postopen event

script will copy the user’s Notes ID file and Personal Address Book to the user’s
unique network drive, M:\NotesR5 in our example. Then it will copy the Business

Card/Contact and Group documents into the user’s mail file. In order to copy

documents from the Journal database into the user’s mail file, the script has to be

enhanced further. At the end, a reply message is sent to the iNotesConvert

database containing the status, indicating whether the operation succeeded or

failed.

Example 3-1 LotusScript used in the Postopen event of the iNotesPreparation subform

Sub Postopen(Source As Notesuidocument)
On Error Goto errHandler
Dim session As New NotesSession
Dim ui As New NotesUIWorkspace
Dim uiMemo As NotesUIDocument
Dim memo As NotesDocument
Dim reply As NotesDocument
REM is the data on standard path
Dim notesPath As String
REM path and name of the current used id
Dim notesID As String

REM network path for the new replica, !!use one per user!!

Dim newPath As String

REM define the address of your MailInDatabase
Dim mailBack As String

REM does the mail file reside on the server?
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Dim isOnServer As String
REM was this job already done before?
Dim copyAlreadyExists As NotesDatabase
REM personal address book
Dim db As NotesDatabase
REM new copy of the personal address book
Dim newCopy As NotesDatabase
REM the currently opened mail database
Dim mailDB As NotesDatabase
Dim col As NotesDocumentCollection
Dim doc As NotesDocument
REM $VIMPeopleAndGroups
Dim viewPG As NotesView
REM those will are business cards or group documents
Dim docPG As NotesDocument
REM it will be the field ‘“iNotesConvert’
Dim item As NotesItem
notesPath = session.GetEnvironmentString(“Directory”, True)
notesId = session.GetEnvironmentString(“KeyFilename”, True)
REM drive + path where you want to store the user’s ID, the
REM preferrably in a networking drive
newPath = “M:\NotesR5”
REM you should create a MailInDatabase document for this!
mailBack = “iNotesConvert@iNotesMig”
Set uiMemo = ui.CurrentDocument
Set memo uiMemo.Document
REM sender and consignee of the mail have to be different - this is
REM mandatory!!
If uiMemo.IsNewDoc Or memo.From(0) = session.UserName Then
Exit Sub
End If
REM just stop if this job has been already done before - don’t do
REM this twice
If memo.iNotesPrepDone(0) = “1” Then
Exit Sub
End If
%REM
if the mail file resides local we stop now! - For security reasons
we send an email to the original sender, so he can send this mail
again to this user
%END REM
REM resides the mail file on server?
isOnServer = session.CurrentDatabase.Server
If isOnServer = ““ Then
Set reply = memo.CreateReplyMessage(False)
reply.Subject = “IWA preparation most Tikely has failed!”
reply.Body = memo.SendTo(0) & “ has opened the IWA“& _
“preparation memo in his local mail file! To cover the users ID “ & _
“and necessary documents from the Personal Address Book only “ & _
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%REM

%END

%REM

%END

%REM

“will work, when the user’s mail file location is: on Server!” & _
Chr(13) & Chr(13) & “Consider it best to send a new IWA “ & _
“preparation mail to the user!”
Call reply.Send(False)
REM we are Tocal - stop and ciao!
Exit Sub
End If
REM if the directory already exists, we’11 handle it by the error handler
Mkdir newPath
REM no matter whether the id already exists, we do it again
Filecopy notesPath + “\” + notesID , newPath + “\” + notesID
REM in case the personal address book already exist, we stop now!
Set copyAlreadyExists = New NotesDatabase(*“*“, newPath + “\names.nsf”)
If (copyAlreadyExists.IsOpen) Then
REM address book already copied - stop and ciao!
Exit Sub
End If

We copy the private addressbook to the network

We didn’t took type 1. and 2., as ...
‘... Notes doesn’t Tike this
1. filecopy notespath +”\names.nsf”, “{drive}:\names.nsf”
‘... it works, but takes too much time and the user will see it
2. Set replica = db.CreateReplica(*““, newPath + “\names.nsf”)
3. it seems Tong winded to copy the database without documents ...
REM
Set db = New NotesDatabase(*“*, “names.nsf”)
If Not db.IsOpen Then Call db.open(““, “names.nsf”)
Set newCopy = db.CreateCopy(““, newPath + “\names.nsf)
REM ... and now to copy the documents...
Set col = db.AT1Documents
Set doc = col.GetFirstDocument ()
Do Until doc Is Nothing
Call doc.CopyToDatabase(newCopy)
Set doc = col.GetNextDocument (doc)
Loop

we’11 gonna merge the Business Cards & Groups from the Personal Address
Book into the user’s mail file as we do it only once, we don’t proove
for duplicate documents - just change the script for a duplicate check
REM

Set mailDB = session.CurrentDatabase

Set viewPG = db.GetView(*“($VIMPeopleAndGroups)™)

Set docPG = viewPG.GetFirstDocument()

Do Until docPG Is Nothing

a simple way to hide the documents in the R4.x mail file could be, to
change the selection formula in the appropriate mail template in the
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view: ¢($A11)° to °!@isavailable(“iNotesConvert™)’

%END REM
Set item = docPG.AppendItemValue(“iNotesConvert”, “1%)
docPG.iNotesConvert = “1”
REM the field: ‘iNotesConvert’ to the document
Call docPG.Save(True, True, True)
REM copy it to the mail file
Call docPG.CopyToDatabase(mailDB)
Set docPG = viewPG.GetNextDocument (docPG)
Loop
%REM

...and finally we are going to send a mail to the MaillnDatabase
we called “iNotesConvert’

%END REM
Set uiMemo = ui.CurrentDocument
Set memo = uiMemo.Document
Set reply = memo.CreateReplyMessage(False)

reply.SendTo = mailBack
reply.Subject = “IWA preparation - ID and privat N&A have been copied”
reply.Body = “User.ID and Private Address Book have been copied “ & _
“to the appropiate directory: °” & newPath & “¢1”
reply.iNotesPrepDone = “1”
Call reply.Send(False)
REM this script will never run again - but only from the eMail!
memo. iNotesPrepDone = “1”
Call memo.save(True, True, True)
REM now we could tell the user what we did? - we decided not to do so;-)
REM e. g. (to present this messagebox, remove the single quotation marks)
‘Msgbox (“Your system will be upgraded to IWA soon. Therefore your “ & _
‘?ID und documents of your Personal Address Book have been saved! - “ & _
‘*These documents will be available to you after the upgrade! - “ & _
“*Your NotesTeam™)
Exit Sub
errHandler:

REM if “Path/File access error”
If Err = 75 Then

Print “Error: “ & Err & “ --- “ & Error & “ in Tine: “ & Erl

Resume Next
REM any other error
Elseif Err > 0 Then

Print “Error: “ & Err & “ --- “ & Error & “ in line: “ & Erl
Resume Next
End If

End Sub

5. Insert the subform into the copy of the Memo form using the following steps.
a. Make a copy of the Memo form.
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b. Insert the subform at the very beginning of a copy of the standard Memo

form.

c. Enable the Store form in document attribute of the form’s properties, as
shown in Figure 3-7.

Basics ! Defaults \ Launch \ Background \ ﬁ\ﬂ\

[T Defaul database form [ 15 b
[T Disable Field Exchange [ Autornatically refresh fislds

On Create:

Form B4 kM B

[~ Formulas inkerit values from selected document

[ Inherit entire selected document into rich text fisld:

On Open:

[ Automatically enable Edit Mode
I~ Show context pane:

On Close:

[~ Present mail send dialog

For Web Access:
[T Treat documert contents as HTML

Figure 3-7 Form properties for iNotesPreparation Mail form

d. Enter iNotesPreparation Mail as the name of the form.

e. Save and close the form.

f. Enable the Allow use of stored forms in this database property in

Database properties, as shown in Figure 3-8.

Databaze

@ii&;«?O\E

Title
Server
Filename

Tyupe
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STR1/SRYANOTESMIG
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Dizplay images after loading

¥ Weh access Use JavaScript when generating pages

‘web access: Require 551 connechion

Figure 3-8 Database settings for the iNotesConvert database
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Sending out the preparation mail message
Send the preparation message to all users to be migrated.
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Ta Sandra Bullock/USRANOTESMIGEINOTESMIG
cCl

Subject:  THIS IS AN IMPORTANT NOTICE TO YOU REGARDING YOUR MAIL
FILE!

Hi Sandra,
wour mail file will be updated for upcoming release of iNotes!
Fegards,

Your Notes - Tearm

N o

| T g “|=2|Sandra Bullack| €55

Figure 3-9 iNotesPreparation mail has been opened by the user

When the user opens the message from the mail file on the server, the script
runs and the necessary actions are taken.

You are now ready to convert user’s mail files, which is described in the next
section.

3.4.3 Converting mail files to iNotes Web Access

58

Refer to the Domino documentation: Moving to Notes and Domino Release 5 for
additional information.

Use the NT prompt and the mail convert utility to convert mail files to the new
iNotes Web Access design.

Syntax: nconvert [-r] filename 0ldDesignName NewTemplateName

The -r switch indicates the change should be done recursively in subdirectories.

Example syntax from the NTprompt:
nconvert -r mail\*.nsf StdR50Mail iNotes5.ntf
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where StdR50Mai 1 is the design name. This example replaces all mail files in the
data\mail directory that have the design called STDR50Mail with the design that’s
contained in inotes5.ntf. The -r switch does this recursively for all files in
subdirectories of data\mail.

Another example:

nconvert mail\*.nsf * inotes5.ntf

This example replaces the design of all files in the data\mail directory with the
design in iNotes5.ntf. It does this no matter what the name of the previous design
was. When you are done converting mail, send users an upgrade notification
message (see 3.5.1, “Deploying iNotes Web Access for online users” on

page 60).

It is a good idea to compact and archive all mail databases before you start
converting your users. Then convert your users to iNotes Web Access, and after
the conversion, rebuild all your views to make sure they are up to date. Table 3-5
shows the server console commands you can use to perform these operations.

Table 3-5 Commands related to compacting and converting mail files

Command Description
load compact -a mail\* Compact and archive databases in the mail
directory.

load convert mail\* * iNotes5 | Convert all databases in the mail directory to
the iNotes5 template.

load updall Rebuild views in all the databases on this
server.

3.5 iNotes Web Access client deployment

When a Domino Administrator is planning an iNotes Web Access deployment,
Domino Off-Line Services (DOLS) can be turned on or off.

If you are not planning to have offline users, iNotes Web Access offers a simple
deployment model with no-touch desktop installation.

If DOLS is turned on, it will maintain full fidelity of the iNotes Web Access
environment on the local desktop. A local installation of DOLS is required on the
client side.
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3.5.1 Deploying iNotes Web Access for online users

If you are not planning to have off-line users, all you have to do to make iNotes
Web Access available to Web browser users throughout the enterprise and
beyond is register the users with Domino and send each user an upgrade
notification message.

After upgrading mail templates for existing users or creating new mail files using
iNotes5.ntf mail template for new users, the administrator just sends users an
upgrade notification message with the URL they need to access their mail file.
You should ensure:

1. The fully qualified Internet host name (including domain name) must be used
to access the mail file. For example, use:

http://server25.acme.com/mail/mailfile.nsf
Do not use:
http://server25/mail/mailfile.nsf

2. Remind users to use their Internet password, since it may be different from
their Notes password.

3.5.2 Deploying iNotes Web Access for offline users using DOLS

60

If you are planning to have offline users, first determine how many of the iNotes
Web Access users will require DOLS. Once you determine this number, deploy
these users evenly across the available servers to optimize load distribution.

If not already present, DOLS will install the Lotus iNotes Sync Manager on a
user’s desktop the first time the user goes offline, to provide the conveniences
that you would normally find from the Notes R5 Replicator page.

From Lotus iNotes Sync Manager, you can synchronize any changes between
the mail file on the server and your offline mail file.

Use the following steps to install DOLS in your environment if you don’t have it
installed already.
» Enabling DOLS on Domino installation

DOLS can be enabled during Domino installation. To do this, do the following
as you are setting up and installing Domino:

a. Click the Customize button for Domino Administrator Server.
b. Check the “Domino Server Program Files” box.
c. Check the “DOLS” box (see Figure 3-10 on page 61).
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Figure 3-10 DOLS box on Domino Server installation
» Upgrading an existing Domino V. 5.05 or newer server without DOLS
enabled
a. Enable Domino Off-line Services on the target server.

i. Open the Domino Administrator, open the Server Document for the
target server and select the Internet Protocols/HTTP tab. (See
Figure 3-11 on page 62).
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Figure 3-11 Internet Protocols - HTTP tab - DSAPI filter file names

ii. Forthe DSAPI filter file names field, enter one of values from Table 3-6,
depending on your platform.

Table 3-6 DSAPI filter file names

Platform Value
Win32 ndolextn
0S/2 idolextn
AIX libdolextn
Solaris Sparc libdolextn
0S390 libdolextn
AS400* libdolextn

* Note: For the AS/400 platform, the server document will be updated
when a new server is configured or an existing server is modified using
the CFGDOMSVR or CHGDOMSVR CL command with DOLS(*YES)
specified. Refer to the Domino for AS/400 Release Notes for more
information on configuring a server with DOLS.
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iii. Exitthe Domino Administrator.

. Create and initialize the “Off-line Services” (administration) Database.

Vi.

vi

Open the Notes client.

Create a doladmin.nsf (DOLS security policy) database by choosing
File -> Database -> New.

In the New Database window, type doladmin.nsf as a file name, type
0ffline Services for the Title and use the template “DOLS
Administration Template 1.0.” (Figure 3-12).

Note: You must check the box labeled “Show Advanced Templates”
in order to see the DOLS Administration template.

. Specify the target Domino server where DOLS is to be enabled as the

name of the “Server” and “Template Server” for the new database.
Click OK to create the database.

MNew Database
Server  [RIDT/SRVANDTES | oK. |
Title: IfoIine Services (] |
File Mame: ;doladmin.nsf g Help |

Encryption... I Size Limit... |
[~ Create full test index for searching AdﬁanCEd---l
Template Server... I RIOT/ASEVANDTES

DECSS Administrator Template :_i
Dresign Synopzis Template

Diirectory Azsistance == |
Diirectory Catalog

Dizcuzzion - Motes & wWeb [RE.0]
[Doc: Library - Motes & web [R5.0

‘DOLS &dministration Template [1

About.... | doladmintf

V' Show advanced templates [V Inherit future design changes

Figure 3-12 Creating a new DOLS Admin database

Choose File -> Database -> Open and open the Offline Services
database (doladmin.nsf) created on the target server in the previous
steps.

. Select the “New Security Policy” option to create one or more DOLS

security policies for the target server. The default behavior (if you do
not specify a Security Policy) is to prompt end-users to provide ID files
when going offline. You can explicitly control and override that default
for given security domains by setting to “Automatically generate user
IDs” or “Use NAB for ID lookup”.
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Figure 3-13 New DOLS Security Policy

viii.Exit the Notes client.

¢. Shut down and then re-start the target server. DOLS is now available on
the server.

Attention: At startup, the console message Domino Offline Services
HTTP extension <Release version> loaded should have appeared. If it
did, the DSAPI file filter extension field is populated correctly.

» Checklist - DOLS installation

a. If you currently use DOLS and are upgrading, make sure Internet Explorer
users have deleted the LotusDRSControlClass object.

To delete the LotusDRSControlClass object, open the Internet Options
menu, click Settings -> View Objects, right-mouse click the
LotusDRSControlClass object, and select Remove from the right-mouse

menu.
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Figure 3-14 Deleting LotusDRSControlClass object

These steps force the user's browser to upgrade to the new DOLS plug-in
or ActiveX components. The first time a subscription is installed from an
upgraded server, the client software is automatically upgraded.

b. Make sure users have Internet Explorer 5.01 Service Pack 1 or above
installed.

c. Make sure the following are the same:

* The server's TCP/IP name as registered with the network (on the
server document, TCP/IP properties, DNS tab).

* The server name (on the server document, Basics tab, Server name
field).

e The Internet host name (on the server document, Basics tab, “Fully
qualified Internet host name” field).

For example: acme.lotus.com - “acme” is the machine name, host
name for DNS, and Domino server common.

d. Make sure all users have hierarchical names. DOLS does not currently
support flat names.

e. If downloading DOLS over a phone line:

* Open the Server document. At the HTTP tab, change the Output
timeout to 300 minutes (Figure 3-15 on page 66) to allow enough time
for downloads.
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f.
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Figure 3-15 Output timeout field on Server document

Make sure that Anonymous has No Access in all of the Mail files

(Figure 3-16).
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Figure 3-16 Anonymous access in ACL

g. Make sure that the DSAPI filter file name is correct, depending on your
platform (Figure 3-11 on page 62), and that you have created a DOLS
Security Policy (Figure 3-13 on page 64).

Note: To enable users to take the server’s directory catalog offline with
their malil files, the parameter $DOLSDirectoryCatalog in the server’s
NOTES.INI file should be set to the name (relative to the data directory)
of the directory catalog file for off-line use. If this NOTES.INI parameter
does not exist, users will not have the option to take a server directory
catalog off-line with their malil files.

» DOLS CD installation

This installation is preferable for users with large mail files and/or users who
access Domino servers using either low bandwidth or dial-up connection.

Once users load the Pre-Installer CD, DOLS will load installation and initial

mail file subscription data from a local cache instead of the server connection.
You can download the setup files from:

http://www.lotus.com/home.nsf/welcome/offlineservices

The Domino Offline Services CD can contain the client driver filesets and the
mail file subscription. The client driver filesets are already installed on the CD.
Perform the following steps to add subscriptions and custom filesets:

a. Create replicas of the mail file subscriptions you want to add to the CD.
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Any mail file you add to the CD must have the same replica ID as the
original. You cannot make a “new copy” using the Notes client, since new
copies have new IDs.

You can create a “stub” malil file for the CD, meaning only the design
elements are added. To create a stub mail file, make a replica of the
database containing only the design elements. During the user's first
synchronization, the documents will be added.

. In the directory \Contents\Subscriptions on the CD, create one folder for

each subscription. Name each folder with the replica ID of the main
database of the subscription. For example:

\Contents\Subscriptions\72638271927F46D8

Note: There is a hidden field in the Profile document which contains the
database replica ID.

. In each subscription folder, add the subscription in a directory structure

exactly matching the subscription’s directory structure on the Domino
server. For example, if the DOLS-enabled mail database joe.nsf was
located in \Data\Mail on the server, then you'd add the following to the CD:

\Contents\Subscriptions\72638271927F46D8\Mail\joe.nsf

. If you want to use a directory catalog off-line, create a Directory Catalog

folder under \Content\Subscriptions\<replica id> and add a replica of the
catalog.nsf. For example:

\Content\Subscriptions\72638271927F46D8\DirectoryCatalog\nameofcat
alog.nsf

Note: If the Directory Catalog is an optional file, in the Offline
Configuration Document of the online mail file (Figure 3-17 on page 69),
the “Automatically replicate new DBs” check box in the Optional Files to
Replicate section must be checked for the file to be replicated the first
time. Another option (recommended) is to set a default directory catalog
by adding $DOLSDirectoryCatalog=nameofcatalog.nsf to the notes.ini
on the server. If you set a default, it is installed with every subscription
unless you specify a different catalog in the Directory Catalog file name
field.
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Figure 3-17 Offline Subscription Configuration

To create a custom program

To create a custom program to run immediately after install, create a file
called dolscontent.ini in the directory \Contents on the CD. Make the first
line [DOLS]; the second line SetupProgram=; and the third line
SetupCommandLine=. Add the name of any programs you want run to the
SetupProgram= line. Add any specific commands you want to the
SetupCommandLine line.

For example, if the first thing you want to happen after install is for the
user's Explorer browser to open to the URL of the application “foo,” add
the following to dolscontent.ini:

[DOLS]
SetupProgram=explorer.exe
SetupCommandLine=http:\\www. foo.com
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» Working offline

After DOLS installation, working offline allows users to access the information
in their mail files when their computers are not connected to a network. When
you work offline, you can create messages, schedule meetings, respond to
e-mail, and do most of the same things you can when you are online.

Note: When working with folders offline, you need to refresh your browser
when returning online to see the newly added, changed, or deleted folders.

To work offline, click Go Offline on the task bar while in iNotes Web Access.
This will give you access to a Go Offline button; click this button (Figure 3-18)
for a menu of options.
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Figure 3-18 “Go Offline” menu options

If this is the first time you go offline, you are prompted to install iNotes Web
Access as a subscription on your local machine, and also to install Lotus
iNotes Sync Manager. A subscription includes your mail file, help, related
databases, and property settings. If download time is an issue, you can also
use a CD-ROM to install the Lotus iNotes Sync Manager (see “DOLS CD
installation” on page 67).
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The Lotus iNotes Sync Manager installation will prompt you for the name of a
new folder in which to install Lotus iNotes (Figure 3-19).
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Figure 3-19 Folder name to install Lotus iNotes Sync Manager

While installing the subscription, you may be prompted for your Notes ID
(Figure 3-20), depending on the offline security policy settings on the server,
which were described previously.
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Figure 3-20 Prompt for Notes ID

Note: If you are a Notes client user, you can use your regular Notes ID file,
usually stored in the \notes\data directory.
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Once the download finishes, Lotus iNotes Sync Manager opens automatically
(Figure 3-21).
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Figure 3-21 Lotus iNotes Sync Manager

Lotus iNotes Sync Manager is integrated into the Windows desktop and lets
you manage multiple offline subscriptions. With Lotus iNotes Sync Manager,
you can perform the following tasks:

— Open iNotes Web Access offline to use as if it were online and connected
to a network server.

— Set standard synchronization settings including schedule and frequency.

— Synchronize the online and offline versions of iNotes Web Access with
each other.

If you want to look up mail addresses or send meeting invitations while
working offline, it's recommended that you include the server's name and
address book or directory catalog when you go offline. Make sure this
preference is enabled.

Restriction: You cannot change spelling dictionaries when you are

working offline. When offline, your spelling dictionary is set by the default
language selected on the server.

3.6 Uninstalling iNotes Web Access client

Follow these steps to uninstall iNotes Web Access:
. Delete the upload control in your browser's object cache.
a. Open your Internet Explorer browser.

b. Select Tools -> Internet Options from the menu.
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c. Under “Temporary Internet Files”, click Settings.
d. Click View Objects.

e. Right-click the file iNotes Class and from the context menu, select

Remove (Figure 3-22). If you used iNotes Web Access to go offline, then
also right-click on the file LotusDRSControl Class and from the context

menu, select Remove (Figure 3-14 on page 65).
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Figure 3-22 Remove iNotes Class

f. Close the Object Window, click OK, then click OK again.

2. Remove the temporary iNotes Web Access files from your browser's cache:

See 2.5.1, “How to manually delete temporary Internet files” on page 30.

3. If you have launched any attachments, an iNotes Web Access directory has
been created as a subdirectory of your system TEMP directory, for example,

c:\temp\iNotes Web Access. Remove this directory. The directory is
automatically removed if the iNotes Web Access version you are using is

5.0.9 or later.

“Lotus iNotes.”

This step is necessary only if you went offline with iNotes Web Access.
a. From the Windows Start menu, select Programs -> Lotus iNotes.

b. Select Uninstall Lotus iNotes.
c. Click the Uninstall button (Figure 3-23 on page 74).
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Figure 3-23 Uninstall Lotus Sync Manager

d. Click Yes (Figure 3-24).

i Uninstall Lotus iNotes

Are you sure you want o uninstall Lotus iMotes From c:iprogram filesiLotus ibotes?

Figure 3-24 Uninstall Lotus iNotes confirmation

3.7 Directory Assistance and Directory Catalog

iNotes Web Access can use other directories made accessible through
configured Directory Assistance on the Domino server. Within the Select
Addresses dialog box you can search and find people from all directories defined
in Directory Assistance and also from the Directory Catalog.

3 Select Addresses - Microsoft Internet Explorer [E[E

Search: Contacts vl o
Contacts
Search

iMotes Domino Directd
arnm anm

Exit

Figure 3-25 Select Addresses dialog box

74  iNotes Web Access Deployment and Administration



A Select Addresses - Microsoft Interne___ [H[E B3

Search: iMotes Domino Dire 'I o
Find: |lo Search |
#a| ocalDomainCatalogServers
del ocalDomainServers Td:@
&Lopez , Jennifer

(=

bec:

Exit

Figure 3-26 Find & Search within Domino directory

For more information about Directory Catalog, and how to configure the Domino
server for Directory Assistance, refer to the Domino Administration Help
database (help5_admin.nsf).

3.8 Welcome page

The Welcome page is designed to be fully customizable, to easily meet the
needs on a per-user level, a group level, or even an organization-wide level. To
deploy customized Welcome pages for groups or subgroups, each server will
maintain a single “uniquely customized” Welcome page. A Server Configuration
Document in the Domino Directory can be used to configure the unique Welcome
page on a per-server basis. To provide an organization-wide Welcome page, just
complete the information on the iNotes Web Access tab in the * - [all servers]
Server Configuration Document.

Note: If an iNotes Web Access user specifies a Personal Page Layout as their
Welcome page, that setting takes precedence over the setting the Domino
Administrator has configured in the Server Configuration Document.

Figure 3-27 on page 76 and Figure 3-28 on page 77 show an example of how to
set up the Welcome page URL and Welcome page title on the iNotes Web
Access settings in the server configuration document.
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Figure 3-27 iNotes Web Access settings in the Server Configuration Document
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Figure 3-28 Welcome page deployed by the server

Note: If you set a default URL and are running Internet Explorer 5.01, the
default page pane hides some of the submenus in iNotes Web Access. This is
caused by a limitation in Internet Explorer 5.01. You can see all the submenus
if you are using Internet Explorer 5.5.

Note: As with Domino 5.0.9, you have to be careful which characters you're
using for the title. For example, the use of a single quotation mark may cause
the browser to show pages incorrectly or result in a series of errors.

3.9 Server deployment - quick reference

The following steps identify how to easily set up iNotes Web Access for an
existing environment:

1. Plan for capacity.

Refer to Chapter 4, “Scalability and performance” on page 79 to determine
the required number of servers to support your organization size.
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. Install or upgrade software.

Install Domino server, version 5.0.8 or newer, on the required number of
servers. If you are upgrading an R4 server, refer to the redbook Lotus Notes
and Domino Take Center Stage: Upgrading from R4 to R5, (SG24-5630).

. Verify the correct server settings.

See 3.3, “Server configurations” on page 44.

. Enable the HTTP server task.

See 3.3.3, “HTTP task” on page 47 and refer to the Domino 5 Administration
Help for more details.

. Plan offline support and enable DOLS on each server that will be supporting

users for off-line access.

See 3.5.2, “Deploying iNotes Web Access for offline users using DOLS” on
page 60.

. Create new user accounts using the iNotes Web Access design template

(inotes5.ntf) or convert existing users.

See 3.4, “Migration of users” on page 48.

. Pre-configure a Welcome page.

See 3.8, “Welcome page” on page 75.

. Notify online and offline users with instructions.

See 3.5, “iNotes Web Access client deployment” on page 59.
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Scalability and performance

This chapter provides information to help you size, configure, and tune a Domino
server for optimal performance and scalability when using iNotes Web Access
clients. Our design guidelines include requirements for server scalability,
capacity, performance, network utilization, high availability, and response times.

In this chapter, the following topics are discussed:

>

>

'S

Capacity planning

Client/server performance and scalability
Server performance

Adding DOLS to improve server scalability
Clustering

Hardware configurations

iNotes Web Access to WebMail comparison
Network bandwidth utilization
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4.1 Scalability and capacity planning

One of the main goals for iNotes Web Access is to provide a faster performing,
better scaling, yet fully functional Web client. Internal benchmarks demonstrate
that this goal was significantly achieved.

This section provides information that will help you to size your iNotes Web
Access environment. Trying to size a server to be the best for your environment
is usually a complicated task. In this section we provide guidelines for this task,
show you the results of some internal tests, and point you to other sources for
specific information related to your environment.

4.1.1 Hardware sizing tools

80

A number of helpful sizing tools are available on the Web. These tools can help
you determine which kind of server would be best for your environment. You can
specify your preferences, such as number of users, concurrent users, type of
users, hardware preferences, and the tools analyze you requirements to help you
find the best server for your organization.

These tools are provided by hardware vendors. The tools are often developed by
the same individuals who conduct NotesBench testing and who also help
customers size Domino and iNotes Web Access deployments.
Sizing tools are available for the following products:
» IBM xSeries (Neffinity) servers
http://www.developer.ibm.com/welcome/myvc.pl
» IBM iSeries (AS/400) servers
— IBM Workload Estimator for AS/400 Servers
http://as400service.ibm.com/estimator
— Domino for AS/400 Application Sizing Examples
http://www.as400.ibm.com/domino/d4appsz.htm
» IBM zSeries (S/390) servers
— Processor Capacity Reference (PCR) tool
http://w3.ibm.com/support/wsc
(Click S/390 - Capacity Planning - Tools - PCR)
» IBM pSeries (AIX) servers
— Server Planning database - Lotus Sales Tools 5 ()
— Server Planning database - Web site
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http://atsdaixl.s1.dfw.ibm.com
» Compagq servers

http://vcmproapp02.compaq.com/aasizercode/aasizer.asp?sizername=DominoR

For more information about sizing tools, refer to the Domino Performance Zone
athttp://www.lotus.com/performance.

4.1.2 Tools used for measuring server performance: NotesBench

NotesBench for Lotus Notes is a collection of benchmark workloads that simulate
the behavior of Domino workstation-to-server or server-to-server operations.
Using NotesBench, vendors and other organizations evaluate the performance of
various Domino and Notes platforms and configurations. Lotus provides
NotesBench to hardware vendors and qualified Lotus Business Partners. Using
the tool, vendors and business partners generate benchmark information, which
they can distribute to their customers. In turn, customers can use the benchmark
information to evaluate vendors, select configurations, and plan resource
budgets.

To use NotesBench, you must be a member of the NotesBench Consortium,
which is an independent, non-profit organization dedicated to providing Domino
and Notes performance information to customers. The consortium requires that
each member run the NotesBench tests in the same manner and allow tests to
be audited. You can visit the NotesBench Web site at:

http://www.notesbench.org
A NotesBench workload for iNotes Web Access has been created and supplied

to members of the NotesBench Consortium. Members have committed to
providing audited NotesBench reports for iNotes Web Access in the near future.

NotesBench is considered a standard for Domino benchmarking and the results
of these benchmarks can also be found on www.ideasinternational.com along
with other industry standard benchmarks.

4.1.3 iNotes Web Access server performance tests

The IBM Westford Lab performance team did some internal scalability
benchmarks for iNotes Web Access. The goal of these tests was to simulate
iNotes Web Access usage on a tested configuration.

The iNotes Web Access messaging workload used in this test was:

» On Nth iteration (Usually 6th iteration which is every 90 minutes)

a. Create a new Message
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b. Add 3 recipients
c. Submit message

» Every iteration (every 15 minutes)

@ "0 00T

Open Inbox

Read 1st message

Delete 1st message
Read 2nd message
Read 3rd message

Read 4th message

Read 5th message

Note: The messaging workload did not do any actions related to calendaring and

scheduling.

The purpose of these benchmark tests is to demonstrate platform scalability and
resource utilization in specific workloads. The test was not meant to compare
different platforms. Information from the tests can be used as a guideline for
capacity planning purposes.

Results of the peak benchmark tests
The tests were performed on two platforms with two different configurations.

» IBM eServer pSeries S80 running AIX 4.3.3

Table 4-1 Results of scalability test on pSeries platform

Number of | Memory | Number | Response |% CPU % CPU/ | Transaction/ | Transactions/
CPUs (400 of users |timein utilization | user minute user

MHz each seconds

12 16 GB 5850 0.255 95 0.033 3469 0.59

4 4GB 2500 0.781 98 0.039 1500 0.60

Data on two SSA loops with 165 9 GB drives, each configured as one RAID 0

Logical unit.

» IBM Netfinity 5500 M20 running Windows2000 SP1
Table 4-2 Results of scalability test on Windows2000

Number of | Memory | Number | Response | % CPU % CPU/ Transaction/ | Transactions
CPUs (550 of users | time in utilization | User minute luser
MHz each seconds
8 25GB 4500 0.534 90 0.02 2654 0.59
4 25GB 2500 1.000 79 0.031 1463 0.59
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Data on three EXP 200 9 9 GB drives, each configured as one RAID 0 Logical
unit (for the 8-way). Data on two EXP 200 9 9 GB drives, each configured as one
RAID 0 Logical unit (for the 4-way).

All tests showed less than 1 second response time. A response time equal to or
less than 1 second is considered acceptable. The number of users is increased
by 250 until the response time is over 1 second. This result is then discarded and
the previous one is used for final results.

A performance test on the iSeries platform

Table 4-3 shows results from tests the iSeries Domino performance team made
with iNotes Web Access on an iSeries platform. The purpose of these tests was
to look at various tuning capabilities and settings. Note that this was not a peak
performance test, and therefore it is not comparable to tests in the previous
section. Rather, the goal was to generate sizing data, with a workload that is
running at 70 to 80 percent CPU capacity, that is not constrained by factors such
as network, disk, or main store (memory).

If fact, the data obtained from these tests was used as input for the iSeries sizing
tool, the Workload Estimator. (See 4.1, “Scalability and capacity planning” on
page 80.)

The following measurement information was collected on an iSeries model
820-2438 running OS/400 V5R1. This system would have performance
equivalent to the Dedicated Server for Domino (DSD) model 820-2458. The
system was configured with 43 9 GB disk drives and RAID5 protection.

Table 4-3 Results of performance tests on iSeries platform

Number of Memory pool | Number of Response Average CPU | Average disk
CPUs (600 size users time in utilization busy

MHz each seconds utilization

4 3.1 GB 2000 0.133 77% 1.0%

4 1 GB 2000 0.214 79% 6.3%

4.1.4 Mixed workload tests

The mix of Notes clients and iNotes Web Access clients in your user community
has a big impact on actual server workload.

The IBM Westford Lab performance team conducted tests with a variety of mixed
client workloads. Testing was done on an IBM Netffinity 4-way 500 MHz Server
with 2.5 GB of memory and two 9-disk exp15 RAID 0 Arrays for the data.
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Workloads used were the iNotes Web Access messaging workload (described
previously) and the R5Mail workload. (A description of the R5Mail workload is on
the NotesBench Web site.)

Benchmarks were run with 100% R5Mail (Notes R5 Client) simulated users,
100% iNotes Web Access simulated users, and a 75/25 and 50/50 Notes R5
Cllient to iNotes Web Access user load. This was not a maximum users test, but
instead testing on a reasonably loaded server to see the effect of different mixes
of clients.

The following results were obtained for the specific workload and configuration:

» With 100% simulated iNotes Web Access users there were 2000 total users.

» With 50% simulated iNotes Web Access users and 50% simulated R5Mail
users there were 4000 total users.

» With 25% simulated iNotes Web Access users and 75% simulated R5Mail
users there were 5000 total users.

» With 100% simulated R5Mail users there were 6000 Total users.

4.2 Client/server performance and scalability

In this section we explain why iNotes Web Access shows improved performance
on both client- and server-side.

4.2.1 Client-side
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There are several things that impact client performance, including:

» The number of total bytes downloaded from the server to the browser for the
page

» The complexity of server-side formulas and logic to generate the page

» The total number of files that comprise the page

» The HTML and client-side logic needed to generate the page

To boost client performance, the code is separated from the data as much as
possible. In this manner, most of the code is broken up into external script files,
which are downloaded once and then very efficiently cached within the browser's
temporary Internet files folder. The JavaScript code is also streamlined to
minimize page size and boost performance. There is also extensive use of
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cascading style sheets to reduce the size of the HTML and minimize the sizes of
bitmaps on the page. In many situations, the need to reload an entire page is
minimized by getting only the new data necessary and rebuilding the HTML with
client-side code.

There is no JavaApplet used with iNotes Web Access itself. Only when you are
using the chat functionality (via the Chat button) will a Sametime Java Applet be
loaded.

To allow a more Windows-like experience manipulating attachments (drag and
drop), a custom ActiveX upload control is used.

If you opt to go off-line with DOLS, another ActiveX component will be used by
DOLS to communicate the off-line state and interact with the Lotus iNotes Sync
Manager.

4.2.2 Server-side

Factors impacting server-side scalability include things like:
» The amount of disk access required to generate a page
» The amount of server-side computation required to generate a page

» The amount of contention among server threads processing separate
requests

» The number of requests received from each user

To boost server-side scalability, lots of server-side caching of forms and
subforms across all users on the same server is employed (Forms5.nsf).
Traditional Domino Web applications have forms and subforms in each and every
end user database that are not cachable across multiple users. Further, many of
the static external files within a Web page are set up to be very efficiently cached
by the browser. This should reduce the amount of requests to the server as a
user continues to use the application. Lastly, there is caching of certain data to
minimize the computation required to generate subsequent pages and boost
both client- and server-side performance.

4.3 Configuring your server for performance

This section describes ways to increase the performance of iNotes Web Access
servers by changing or fine-tuning Domino settings to suit your environment.

In this section we cover:

» Configuration and tuning
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» MailBox configuration

» Tuning network timeout values

» Optimizing HTTP thread settings

» Minimizing view rebuild times

» Reconfiguring server cache settings

» Optimizing Domino server task priorities

» Enabling transaction logging

4.3.1 Configuration and tuning
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This section describes platform-specific settings and configurations to achieve
optimum performance on your server.

Windows 2000 Professional, Server, Advanced Server
We suggest the following configuration changes to optimize Windows 2000:

» Multitasking

Control Panel - System - Performance - Application Performance >> Boost =
None

» Paging File
Control Panel - System - Performance - Virtual Memory - Change:

Create a new paging file on a separate disk drive with the minimum and
maximum size = RAM + 10%. Note that the paging file should be on its own
disk drive. We generally recommend that you do not place it on the same disk
drive as your operating system, Domino data files, or Domino transaction log.
Delete the existing paging file on disk C.

Windows NT Server 4.0 SP4 and above
We suggest the following configuration changes to optimize Windows NT:

» File Cache
Control Panel - Network - Services - Server - Properties >> Maximize
» Multitasking

Control Panel - System - Performance - Application Performance >> Boost =
None

» Paging File
Control Panel - System - Performance - Virtual Memory - Change:
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Create a new paging file on a separate disk drive with the minimum and
maximum size = RAM + 10%. Note that the paging file should be on its own
disk drive. We generally recommend that you do not place it on the same disk
drive as your operating system, Domino data files, or Domino transaction log.
Delete the existing paging file on disk C.

IBM @server pSeries (AlX)

The following information was provided by the IBM @server pSeries server
organization. Further information may be found at:

http://www.ibm.com/servers/eserver/pseries/

Server tuning settings can dramatically impact performance. Administrators
tuning an AlX server for iNotes Web Access should follow these steps:

1. In the Domino server document, define maxactivethreads n,
where n = [40/no_of_processors].

2. Restart the server.

3. Verify the correct value by inspecting the “MaxActiveThreads” value displayed
by the Domino show stat command. (It will show maxactivethreads *
N-processors.)

4. Run your Domino Web server under load.

5. As your server runs, monitor the CPU run length. It is the value in the first
column of the vmstat command. A run length of 4 is optimal. If the value is too
high, lower the maxactivethreads value by 1 and re-test. If your run lengths
are lower than 4, you can try increasing maxactivethreads.

Sun Solaris

For performance optimization and tuning tips for Domino Server on Sun Solaris,
refer to IBM Redbook Lotus Domino R5 for Sun Solaris, SG24-5969.

IBM @server iSeries — 0S400

The following information was provided by the IBM @server iSeries server
organization.

For the iSeries platform, we recommend specifying
NSF_BUFFER_POOL_SIZE_MB. This is because the Domino servers run out of
their own storage pool, which is typically changed dynamically by the
auto-performance adjuster (WRKSYSVAL QPFRADJ).

If you do not set NSF_BUFFER_POOL_SIZE, Domino will calculate a value to
use based on the total memory of your AS/400, not on its share of the storage
pool. 300 MB will probably work fine for most servers, but a better value would be
determined as follows:
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a. Find which storage pool the server is running out of. You can find this from
WRKACTJOB; default is pool 2.

b. Find the size of the pool while your system is running at steady state (that
is, when QPFRADJ isn’t changing the pool sizes). You can see this with
WRKSYSSTS.

c. If you have multiple partitioned servers using that pool, divide the pool size
by the number of servers using the pool (excluding the *HTTPSETUP
server) and multiply by 3/8. Set NSF_BUFFER_POOL_SIZE_MB in
NOTES.INI to this number.

We generally recommend that you enable “run Web agents concurrently” in the
Server Document (under Internet Protocols/HTTP) for most Web applications,
including WebMail and iNotes Web Access.

Sizing Recommendations for iSeries

The IBM Workload Estimator for iSeries provides sizing recommendations for an
iSeries or an AS/400e running one or more workloads associated with
e-business and/or collaboration, such as Domino, Java, or WebSphere. You can
use the Estimator to size a brand new iSeries or AS/400e with all new workloads,
or to size the upgrade of an existing system (with the original workload set or any
additions) to a new system. Support for sizing iNotes Web Access mail users
was recently added to the Estimator, which also supports sizing with Notes,
WebMail, POP3, IMAP, and iNotes Access for Microsoft Outlook clients, and
Domino applications. The Estimator can be accessed at:

http://as400service.ibm.com/estimator

For further information
Further information may be found at:

http://www.iseries.ibm.com/developer/domino/perform/index.html

IBM @server zSeries — 0S/390

Tune the Domino settings for your environment as you would for the other
platforms. In particular:

» Take the default value for the number of HTTP threads (40) as recommended
previously.

» Take the default for the Notes_ SHARED_DPOOLSIZE environment variable,
which is 8 MB. Our testing has shown this to be an optimal value for the
Domino server in general.

» Explicitly set NOTES_SHARED_DPOOLSIZE_MB to a value between 256
and 768. Domino will not default this value to a percentage of available central
storage on this platform, so you will need to do this yourself. Start at the low
end of this range, and increase as needed. If you think you need more than
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768 MB for the shared dpool size, it's time for you to start planning for an
additional Domino partition.

From a platform standpoint, follow all of the usual guidelines. These are
documented in detail in the performance redbook, Lotus Domino for S/390
Release 5: Performance Tuning and Capacity Planning, SG24-5149. When
planning for an iNotes Web Access configuration, keep in mind that I/O to disk
and the network will be significantly higher than when serving traditional Notes
clients. The server will be more sensitive to non-optimal DASD and network
configurations. Take extra care to spread DASD activity over several volumes,
ensure that controllers are caching properly, and that there is enough channel
bandwidth to the DASD devices. Above all else, monitor the SMF and Domino
data from your environment to look for bottlenecks, particularly early on in your
deployment. For other information regarding Domino server performance in
general, see:

http://www.ibm.com/servers/eserver/zseries/software/domino/domperf.html

4.3.2 MAIL.BOX Configuration

For optimal messaging throughput, start with two MAIL.BOX files enabled. It is
important to recognize that MAIL.BOX grows as messages queue—and this
growth can potentially impact Disk 1/O operations. Therefore, it is important to
monitor MAIL.BOX statistics on the Domino server. Check statistics like
Mail.Waiting and Mail.MaximumDeliverTime. If either or both statistics increase
over time, you should increase the number of active MAIL.BOX files.

4.3.3 Tuning network timeout values

When a Web browser makes a request to a Domino HTTP server process, the
following occurs:

1. Athread is opened.

2. When the request is fulfilled, the thread becomes idle, but remains open.

3. If all available threads are in use, the server will buffer the transaction request
until a thread is free.

Open, inactive sessions can prevent users from accessing your Domino servers.
By specifying appropriate time limits for activities between the Domino Web
server and clients or CGl programs, you can ensure that connections don’t
remain open if there is no network activity between them.

The settings described in Table 4-4, which appear on the Internet Protocols -
HTTP tab in the Server document, allow you to fine-tune your network timeout
values.
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Table 4-4 Network timeout settings

Setting

Description

Input timeout
Default = 2 minutes

The time that a client has to send a request after connecting
to the server. The server uses this field if the client that is
connected to the server is not sending “keep alive headers”
to the server within the amount of time specified. Many
current versions of browsers send keep alive headers and
do not need to use the Input timeout setting. Use this setting
if you have clients connecting to the server using browsers
that are not current versions.

Output timeout
Default = 20 minutes

The maximum time that the server has to send output to a
client. This field applies to local files and requests. The time
limit does not apply to requests that start a local CGl
program. If the server does not send the complete request
within the amount of time specified in the Output timeout
field, the server drops the connection.

CGl timeout
Default = 5 minutes

The maximum time that a CGl program started by the server
has to finish. When the time specified in this field runs out,
the server sends a message to the CGl program. After five
minutes, the server shuts down the program.

Idle thread timeout

No effect, remains in the Server document for backward
compatibility only.

Following are some general guidelines for setting the timeout values identified in

the table:

» The default value of 0 (zero) for the “Idle Thread Timeout” setting means that
an idle thread will be kept open indefinitely. Setting this to 5 or 10 minutes
may improve performance on slower servers, or in high-traffic situations. It
can also help boost performance for some applications that people may log
into and then not actually use for long periods.

» If users report input timeout errors, raise the “Input Timeout” value. This can
be a common problem over dial-up connections; it most typically manifests
when a user submits a form after it has been open for editing for a while.

» A frequent cause of output timeout errors is insufficient cache directory size,
or insufficient system memory to handle multiple requests. Output timeouts
can also occur over slow modem connections when downloading or

requesting a large file.

Make sure you know how long it takes your CGl scripts to execute before you
tweak the “CGI Timeout” value. (The default is five minutes.) If there are many
external processes to run, additional time may be required.
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4.3.4 Optimizing HTTP thread settings

Domino R5 allows you to specify the number of threads the HTTP server can
process, as well as the number of requests a user can make over a single
connection to the server. These settings effectively limit the number of users who
can access the server simultaneously—obviously a big factor in scalability and
performance. Hence it’s often worthwhile to customize these defaults to fit the
servers in your environment. If the maximum number of active threads is
reached, Domino queues new requests until a request finishes and more threads
become available. The more processing power a system has, the greater the
number of threads it can support. Conversely, if a server is spending too much
time on overhead-related tasks, such as swapping memory, you probably need to
lower the maximum number of threads it can process.

You can experiment with the values. However, we recommended that you keep
the default values for these fields. Changes to these values were tested on
various configurations and platforms; the results of the tests showed that the best
performance is reached with default values.

Table 4-5 describes the thread configuration settings available to you; they
appear on the Internet Protocols - HTTP tab of the Server document.

Table 4-5 Settings for HTTP threads on Server document

Setting Description

Number active threads The number of threads that can be active on the server at the
same time. The default is 40.

Minimum active threads | The field has no effect on Domino R5. It remains in the
Server document for backward compatibility.

Maximum requests over | The number of requests a browser can make to the server at
a single connection the same time. The defaultis 1. This setting affects browsers
compatible with HTTP 1.1 or later, if the browser includes the
capability to send multiple requests to a server without
waiting for a reply from the previous request. For more
information, see the documentation for your browser.

4.3.5 Minimizing view rebuild times

A Domino server can perform view rebuild operations as much as five times
faster when you designate a separate drive where Domino can write the
temporary files it creates when it rebuilds views. The greater the space available
on the dedicated drive, the greater the increase in rebuild speed. If your servers
are running up against space constraints in this critical area, you might see a
message like the one shown in Example 4-1.
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Example 4-1 Warning message - View rebuild

06/20/2001 01:13:55 PM Warning: unable to use optimized view rebuild for
Viewname due to insufficient disk space at C:\TEMP. Estimate may need 1045
million bytes for this view. Using standard rebuild instead.

This message indicates that Domino was unable to rebuild the view in the space
available (in this case, in \TEMP, the default) using R5’s highly optimized view
rebuild task. Instead, it reverted to the slower R4 rebuild task. To specify a path
to a dedicated (or roomier) drive, place a command in NOTES.INI of the form:

view_rebuild_dir=X:\pathname\

Note that the disk space R5 needs to rebuild a view can be much larger than the
actual view size as specified when a user selects View Properties. Therefore,
depending on how big your views are in the first place, you may want to take a
little time to evaluate how much disk space you’ll actually need to allocate.

More view rebuild tips
It's worth noting in this context also that:

» R5 can spawn a separate indexing thread for each CPU, on servers with
multiple CPUs. This capability better leverages a multiprocessor platform,
and improves performance; especially for the drive where Domino writes
temporary files during view rebuild operations.

» Views that don’t require frequent updates can, and should, be reindexed less
frequently. For example, the view of an archive where documents come and
go as a result of batch processes can probably be indexed once a day.
Depending on your servers and applications, a few such tweaks could make a
considerable difference.

4.3.6 Reconfigure server cache settings
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One way Domino optimizes performance is via an in-memory cache, where it
stores information about HTTP commands, database designs and/or users.
Caching this kind of information saves the time required to process or recreate it,
and these settings can have a big impact on Web application performance. The
more information you can cache, the better the HTTP server can perform for
users. We know of no threshold beyond which cache size does not improve
performance.

You can fine-tune how much of each type of information is cached, in line with
available server memory resources. In the HTTP Server section of the Server
document, change the settings described in Table 4-6 to adjust a server’s
memory cache.
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Table 4-6 HTTP settings on server document

Setting

Description

Maximum cached
commands
Default = 128

The number of HTTP server commands to cache for
anonymous users. Domino must convert some HTTP
server commands, such as OpenDatabase and OpenView,
to HTML before the server can process the commands.
This conversion process takes time.

Use this field to specify how many commands you want to
store in memory so the next time a user issues the server
command, it is immediately available.

Maximum cached
designs
Default = 128

The number of database design elements to cache for
users. When a user opens a database, Domino maps each
design element name to an identification number. This
mapping procedure takes time.

Use this field to specify how many elements you want to
store in memory so the next time a user accesses that
element, it is immediately available.

Maximum cached users
Default = 64

The number of users to cache. After a user successfully
authenticates with a server, Domino stores in memory the
user's name, password, and the list of groups to which the
user belongs.

Use this field to increase the number of users for whom
Domino stores this information.

Cached user expiration
interval
Default = 120

The time interval in seconds during which Domino regularly
removes user names, passwords, and group memberships
from the cache. You should remove user names,
passwords, and groups memberships from the cache
periodically to force Domino to look up user credentials in
the directory the next time they access the server.

You'll need to evaluate for yourself what values work best for each of these
settings. It's a “tweak as you go” proposition, while keeping an eye on your server
statistics. One trial-and-error evaluation method is to double a value until you see
a degradation in performance, and then lower it from there.

4.3.7 Optimizing Domino server task priorities

In most situations, the operating system runs many Domino tasks; however, only
one or two of them require a higher priority than the rest. For those running
Domino on platforms other than Windows NT, such as IBM AIX or OS/400, you
can alter the priority of certain Domino tasks to improve performance.
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There are several situations where changing the priority can boost overall server
performance. Lotus recommends you consider increasing the priority of Attp and
server tasks relative to others for iNotes Web Access servers.

The commands for altering a process’s priority are system specific. On AlX, for
example, the command renice is used; it can be executed only by the root user.
Since Domino servers are started from user accounts other than root, AIX
customers will need to take extra steps to automatically reconfigure the priorities
for Domino server tasks at startup time. (This may be true on other platforms as
well.)

4.4 Adding DOLS to improve server scalability

iNotes Web Access is fully functional offline and users can take advantage of
that. Among other things, users can read e-mail, write e-mail, and use their
calendars offline, and synchronize with the server at off-hours when traffic to the
server is light.

If users have expensive and slow connections to the Domino server, the
advantages of using Domino Off-Line Services are obvious. Users save both
time and money by working offline.

Even when users have fast or inexpensive connections to the Domino server,
working offline has advantages for the server. By reducing traffic to the server,
you make the server more efficient and more cost-effective.

Using iNotes Web Access offline has another big advantage. When your users
are not using their mail files on the server, the network bandwidth consumption is
decreased.

4.5 Reliability with Domino clustering

You can set up your iNotes Web Access Servers to work in a cluster, to ensure
high availability and performance and to balance the workload between servers.

4.5.1 A Domino cluster defined
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A Domino cluster is a group of servers that lets you provide users with constant
access to data, balance the workload between servers, improve server
performance, and maintain performance when you increase the size of your
enterprise. The servers in a cluster contain replicas of databases that should be
readily available to users at all times. If a user tries to access a database on a
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cluster server that is not available, Domino opens a replica of that database on a
different cluster server, if a replica is available. Domino continuously
synchronizes databases so that whichever replica a user opens, the information
is always identical.

4.5.2 Internet Cluster Manager - ICM

The Internet Cluster Manager (ICM) lets you use Domino clusters to provide
failover and workload balancing to HTTP clients (Internet browsers) when they
access Domino Web servers. This makes your iNotes Web Access servers
highly available to clients. You can run the ICM on any server that is using the
Domino Release 5 Enterprise Server license. You install and configure Domino
clusters as you normally would, and then you configure the ICM. The ICM
supports the HTTP and HTTPS protocols.

The ICM acts as an intermediary between HTTP clients and the Domino Web
servers in a cluster. When Domino Web servers are running in a cluster, they
generate URLs that direct HTTP client requests to the ICM. The ICM maintains
information about the availability of servers and databases in the cluster. When
the ICM receives a client request, it redirects the client to the most available
server that contains a replica of the requested database.

The ICM sends periodic probes to the Web servers in the cluster to determine
their status and availability. When the ICM receives a client request, it looks at
the information in the Cluster Database Directory to find a server that contains
the requested database. The ICM determines the most available server that
contains the requested database, and then redirects the client to that server. This
results in the client closing the session with the ICM and opening a new session
with the selected server. The user may see this as a change in the host name in
the URL. The user may also see the path to the database change in the URL
because the database may have a different path on the target server.

Configuring the ICM

You configure the ICM by making entries in the Internet Cluster Manager section
of the Server document. You can also set up a separate IP address for the ICM
(see “Setting up a separate IP address for the ICM” on page 98). You can then
start the ICM.

You can configure the ICM settings on one server and have more than one ICM
access these settings. This lets ICMs on different servers share a common
configuration. You should include the ICM configuration information on every
Web server in the cluster, not just the server on which you run the ICM, because
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each Web server uses its own Server document to determine how to generate
URLs that refer to the ICM. The Web server obtains the host name of the ICM
from the Server document. The Web server then uses that host name to
generate URLs that reference the ICM.

Use the following steps to configure the ICM:

1. From the Domino Administrator, click the Configuration tab.

2. Expand Server and click All Server Documents.

3. In the Results pane, select the Server document for the server on which you
want to run the ICM; then click Edit Server.

4. Click Server Tasks - Internet Cluster Manager tab as shown in Figure 4-1

on page 96.
£ Server: RID1 /SRY,/INDTES - Lotus Notes
File Edit Yiew Create Actions Text Help \* y) y S \)\ @
T weloome 1l iNotes Dornina Director.. ||_] Sever RIOUSAVINOTES X motes
Fg Save and Close 9 weh...
SERVER: RIO1/SRV/INOTES
Bazics l Securityl Forts l Server Tasks l Internet Protocols l MTAs l Mizcellaneous
Damain Indexer l Directory Cataloger l Internet Cluster Manager l 4
Cluster name: ]
1CM Motes port: TICMPORT 4
1CM 551 keyfile: T keylile kyr o
Allow uzers to browse "Moo=l
databases in the cluster over
HTTF:
Get configuration from: T this server
document | =1
ICM hostname: " itskds8 lotus.co
my
TCF/IP port number T80,
TCPAAP port status: "Enabled ;=]
S5L port number; 443,
S5L port status: T Digabled 1 =1
| = 7] 5| “|=2[Ri01 &3

Figure 4-1 Internet Cluster Manager tab on Server document

5. Complete the fields identified in Table 4-7.
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Table 4-7 Internet Cluster Manager fields on Server document

Field name

Description

Cluster name

The name of the cluster the ICM will service. If this field is
blank, Domino uses the name of the cluster that contains
this server.

ICM Notes port

The name of the Notes port the ICM will use to communicate
with HTTP clients. If you leave this field blank, which is the
default, the ICM can use any Notes port to communicate
with HTTP clients. Enter a port name only if you want to
restrict ICM communication to one specific port.

ICM SSL keyfile

The name of the SSL key file that contains certificates to
identify the ICM when communicating with HTTP clients.

Allow users to browse
databases in the cluster
over HTTP

Lets HTTP clients view a list of the databases in a cluster.
When you enabile this field, users can enter
http://icmhostname/?0penServer as the URL to access.
Entering this URL displays a list of databases on the servers
in the cluster associated with the ICM named in
icmhostname.

Get configuration from

Lets you specify a different Server document to get
configuration information from. This field lets multiple ICMs
share the same configuration.

Obtain ICM
configuration from

This field appears when you select “another server
document” in the field “Get configuration from.” Enter the
name of the server whose Server document contains the
configuration you want to use.

ICM hostname

The fully qualified name of the host that clients should use
to communicate with the ICM. This can be the registered
DNS name or the IP address.

The Domino Web server uses this field to create URLs that
reference the ICM. If this field is blank, the Web server will
not be able to generate URLs that refer to the ICM.

TCP/IP port number

Enter the port number for the ICM to use.

If you are running the ICM on the same server as the Web
server, you must avoid address and port conflicts. If you do
not give the ICM its own IP address, be sure the port number
the ICM is using is different from any of the other port
numbers you use on the server.

TCP/IP port status

To enable HTTP communication with the ICM, choose
Enabled. To disable HTTP communication with the ICM,
choose Disabled.

Chapter 4. Scalability and performance 97




98

Field name Description

SSL port status To enable HTTPS communication with the ICM, choose
Enabled. To disable HTTPS communication with the ICM,
choose Disabled.

SSL port number Enter the port number to use for SSL.

If you are running the ICM on the same server as the Web
server, and you do not give the ICM its own IP address, be
sure the SSL port number is different from any of the other

port numbers you use on the server.

6. Save and close the Server document.

When the ICM starts, it looks at the Server document on the server on which it is
running to find the ICM cluster name and its network address. It then obtains the
host name and port settings from the same Server document or from the Server
document specified in the field “Obtain ICM configuration from”.

If you run the ICM on the same system as a Domino Web server, you must avoid
IP address or port number conflicts. The best approach is to assign the ICM its
own IP address. You can also have the ICM share an IP address with the Web
server if you specify different port numbers for the ICM and the other protocols on
the Web server.

Setting up a separate IP address for the ICM
When you run the ICM on a Web server, you can give the ICM its own IP address
to avoid conflicts.

1. Use your operating system to make the IP address available.

2. From the Domino Administrator on the server that contains the ICM, set up a
port by doing the following:

a. Choose Files -> Preferences -> User Preferences.

b. Click the Ports icon, as shown in Figure 4-2.
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Selected part | Show Status...
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ICMPORT Optiors... |
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Figure 4-2 User Preferences - Ports

c. Click New.

d. Specify a name for the new port, such as ICMPORT (see Figure 4-3 on
page 99).

Mame {ICMPORT QK. |

Diriver IT[;P _v_I Eancél I

Uze port at the following locations
v RIOZ/ASRVANDOTES

Figure 4-3 New ICM port

e. Choose TCP as the driver.
f. Click OK twice.

If you are not running the Domino Administrator on the server that
contains the ICM, do the following to set up the port:

* Add the following line to the NOTES.INI file:

Portname=TCP,adapter number or network number,number of sessions,data
buffer size

For example: ICMPORT=TCP,0,15,0
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* Add the name of the port, such as ICMPORT, to the Ports setting in the
NOTES.INI file.

3. Add the following to the NOTES.INI file:

Portname_TcpipAddress=0,IPAddress

Where portname is the name of the port you configured from the Domino
Administrator, such as ICMPORT, and IPAddress is the IP address you are
using for the ICM. For example:

ICMPORT_TcpIpAddress=0,192.94.222.169

. In the field “ICM Notes port” on the Server Tasks -> Internet Cluster

Manager tab in the Server document, enter the name of the port you
configured, such as ICMPORT.

. If you want to use port 80 for both the ICM and the Web server, you must do

the following:
a. In the Server document, click Internet Protocols -> HTTP tab.

b. In the “Host name(s)” field, enter the IP address or host name of the Web
server.

c. In the “Bind to host name” field, select Enabled.

4.6 Hardware configurations

This section will give you some ideas about how to configure your hardware to
achieve better performance on your Domino server.

4.6.1 Hard disk configurations
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The following configurations are recommended for iNotes Web Access servers
running on NT, Windows 2000, and UNIX platforms:

» Employ just a bunch of disks (JBOD) for the operating system. For production

servers, we recommend RAID 0 disk for the operating system.

Employ just a bunch of disks (JBOD) for the View Rebuild directory. For
production servers, we recommend RAID 0 disk for the View Rebuild
directory.

Employ RAID 0 for Domino Data during pre-release testing because of limited
in-house availability of disk drives. However, we recommend using RAID 1 or
RAID 0+1 for Domino Data. It is best to use smaller disks in a RAID array, and
we recommend using disks with capacity under 18 GB each because at this
time they generally have faster access times than larger disks.

» Recommended disk speed is at least 10,000 RPM.
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» Itis recommended that the Swap file be located on a separate disk drive. With
some operating systems, the default location of the Swap file is the same disk
as the operating system itself. If you encounter disk contention, we
recommend that you move the Swap file to a different hard drive.

Note: Be careful to assign the Swap file to a physically separate disk and
not simply to a different partition on the same disk drive. For S/390 and
zSeries, configure your page packs as you would normally. As usual, don’t
let your Domino server page to disk. If this starts to happen, increase the
amount of central/expanded storage available.

» To optimize performance for iNotes Web Access, use a hardware RAID
controller. The hardware RAID controller does not tax the server CPU to the
degree that the software RAID does. For S/390 and zSeries, make sure your
DASD control units are caching properly, and watch that channel bandwidth is
sufficient.

» Lotus has tested on the S/390 and zSeries platforms with different types of
disks (DASDs). We recommend the highest-performance disk available, such
as an Enterprise Storage Server, but iNotes Web Access will work with older
technology disks as well. Performance will be affected accordingly.

4.6.2 Memory

Refer to 3.1, “Server and client requirements” on page 40 for more details
regarding minimum and recommended configurations for each platform.

4.6.3 Other configurations

Refer to 4.3.1, “Configuration and tuning” on page 86 for more suggestions about
how to optimize your iNotes Web Access Server for each platform.

4.7 Comparing iNotes Web Access performance to
Domino WebMail

Although the basic concept of iNotes Web Access and Domino WebMail is the
same—allowing users to access Domino services with a Web browser—iNotes
Web Access provides a lot of more functionality than Domino WebMail does. In
addition, the performance advantage of iNotes Web Access is remarkable.
Internal tests showed that iNotes Web Access outperformed Domino WebMail in
all tested areas, which were:

» Average CPU utilization
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» Average transaction response time

» Number of transactions by CPU utilization

These tests were performed with Domino Release 5.0.8. With Domino Release
5.0.9 there should be an additional increase in server-side scalability, in addition
to other performance improvements.

Performance comparison tests

The Lotus Enterprise Center of Competence performed a test on two platforms,
Windows NT and AlX, to compare the performance of iNotes Web Access and
Domino WebMail. The test was not a platform comparison test or a scalability
test; the goal for the test was to generate equivalent workload on both servers,
one running iNotes Web Access (Domino R5.0.8) and the other one Domino
WebMail (Domino R5.0.5).

Table 4-8 Configuration for the tests

Windows NT AIX

2 IBM Netfinity 7000 4 x 550 MHz Pentium Ill | 2 RS/6000 4 x 332 MHz

2 Gb RAM each 3 Gb RAM each

150 Gb RAID5 EIDE Disk Array each 150 Gb SSA RAID5 Array with
Fast Write Cache on each server

Windows NT Server 4.0 Service Pack 6a AlX 4.3.3

Both Domino WebMail and iNotes Web Access were set up with 1,500 users and
mailboxes on Windows NT and AlX servers.

The mailboxes were populated to three sizes as noted in Table 4-9.

Table 4-9 Mailboxes used in testing

Mailbox size % used in testing
35 Mb 60%
60 Mb 30%
90 Mb 10%

These sizes were selected to represent small, medium and large mailboxes.
These sizes do not relate to any production environment. They are just variable
sizes that were convenient for the number of users and available disk space.
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The functions tested were basic mail functions, available both in iNotes Web
Access and Domino WebMail. Advanced mail functions, only available in iNotes
Web Access, were not used. The workload was modeled after NotesBench
WebMail workload, but it was not an exact match because of different test tools
used.

The tests showed that iNotes Web Access performs better on both platforms and
on all metrics. The following improvements were shown:

» Average CPU utilization, 35% better
» Average transaction response time, 70% better
» Number of transactions by CPU utilization, 300% better

Another test, made by the IBM zSeries performance team, showed similar
results. This test also compared iNotes Web Access performance to Domino
WebMail, but this time on IBM zSeries. The results of this test showed average
CPU utilization to be 14% better with iNotes Web Access, and the average
response time was 63% better. Also, the 1/O rate to disk was down by 45%, which
had a lot to do with the good response time.

4.8 Caching

Using a Web application can be slow if you need to download a lot of data over
the network. In order to minimize the amount of data to be downloaded, as many
elements as possible are cached. This can be done on the server or on the
client.

4.8.1 Server caching

Traditional Domino Web applications have forms and subforms in each and
every end user database that are not cachable across multiple users. With the
“outsourcing” of forms and subforms of the iNotes Web Access design into a file
called Forms5.nsf (in the iNotes directory on the Domino server), a server-side
caching of those elements for all users on the same server has been achieved.

4.8.2 Browser caching

iNotes Web Access makes a distinction between iNotes Web Access design
elements and personal data, with respect to the browser’s cache. In general, the
HTML in which personal data is generated is set, using the Cache-Control HTTP
response header, to a value of “no-cache,” which advises the browser that it
should not store the page in the browser’s file-system cache. Design elements
such as the JavaScript, .gifs, and blank forms of iNotes Web Access are marked
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with a one-year expiration. This facilitates better performance for iNotes Web
Access when used over a dial-up connection or in a network environment, since
the browser will not attempt to download these design elements if they are
already resident in the browser’s cache (assuming the browser’s setting for
“Empty temporary Internet files when browser is closed” option is not set.)

For additional information about client-side caching, see 2.9.2, “Private data and
browser cache” on page 36.

4.9 Network bandwidth utilization

Network bandwidth utilization by the iNotes Web Access client can vary
considerably, depending on many factors. The IBM Westford Lab performance
team made tests to determine the bandwidth usage of iNotes Web Access. The
observed bandwidth utilization was between 2.7 and 3.2 Kbps/user with short
mail messages on a small private 100 Mbit network. In diverse, enterprise
networks, however, bandwidth utilization may be as high as 6 to 8 Kbps per user.
Estimating the proportion of active users to registered users is a very important
step in calculating requirements for network bandwidth. Once your server is
configured and running, it will be possible to monitor actual utilization and make
adjustments accordingly.
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Integration

Lotus Sametime is a real-time collaboration tool that allows you to communicate
with others instantly. Sametime provides features like online meetings,
awareness, chat, and object sharing.

In this chapter we describe how you can integrate Lotus Sametime into your
iNotes Web Access installation. We also show you how iNotes Web Access can
be integrated into other Web applications.

© Copyright IBM Corp. 2001 105



5.1 Sametime integration

iNotes Web Access users can communicate with one another via Lotus
Sametime, which lets users send and receive instant messages and engage in
chat sessions. Users can launch the Sametime user interface by clicking on a link
called “Chat” on the iNotes Web Access Welcome page, as shown in Figure 5-1.
After the Sametime user interface is launched, users can create their own buddy
lists, bringing user names to the list either through Name Picker or simply by
typing the name of the user. The steps to create and use buddy lists is described
in 5.1.4, “Create a buddy list” on page 108.

Sametime applets exist on each Sametime server in the following directory:
\data\domino\htmN\SametimeApplet

These applets are the APIs between iNotes Web Access and Sametime. Using

forms in Domino, iNotes Web Access links the Sametime applets and brings the

instant message to iNotes Web Access users. A user’s buddy lists, from the

Sametime chat user interface, are kept in the user's mail database; they are
brought up whenever the user logs on to Chat again.

Inbox, 5_Wiewhame; 325%24Inbox 32 S2UNH=0r | puhhdbeczSbrmip3kngugn LI {&GD ‘

= Logout@ o Go Offline o) Prefersnces o Help ﬂ

Figure 5-1 Chat button on iNotes Web Access page

Note: Users will see the “Chat” button only if Sametime is installed properly.

5.1.1 Installation and configuration of Sametime
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Note: Running iNotes Web Access server on the same machine or the same
Domino server as the Sametime server is not supported. Sametime must be
on a dedicated machine.

This section describes the procedure to set up and configure Sametime to run
within iNotes Web Access. For more information on configuring the Domino
server for iNotes Web Access, see Chapter 3, “Deployment” on page 39 or refer
to the Domino 5 Administration Help (help5_admin.nsf). For more information on
configuring the Sametime server, refer to the Sametime 2.x Installation Guide.

Following are the high-level steps to set up Sametime.
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1. Install the Domino domain server first.
2. Install the Sametime server, Version 2.x on a dedicated server.

3. Configure the Sametime and Domino domain servers to be able to
communicate with each other and run unrestricted LotusScript/Java agents
(see details in the Sametime 2.x Installation Guide).

4. The required Sametime applets are in the domino\htm\SametimeApplet
folder under your Domino server’s data folder. Copy the Sametime applets
folder from the iNotes Web Access server to the domino\html\ folder of your
Sametime server. After you copy the applet folder you should have following
folders:

— iNotes Web Access server:
c:\Lotus\Domino\Data\domino\htmN\SametimeApplet

— Sametime server: c:\Sametime\Data\domino\htmN\SametimeApplet

Note: On the Sametime server, you will have both a SametimeApplet and
sametimeapplets folder after this step. The folder names are case sensitive.

5. Replicate stauths.nsffrom a Sametime server to the iNotes Web Access
server under the \domino\data directory.

Note: When setting up AlIX and Solaris servers to work with dedicated
Sametime servers, the setup should be the same as a Windows setup. The
only extra step is changing the database name from stauths.nsf to
STAuthS.nsf after replicating the database from a dedicate Sametime server
(Windows system) to a Domino (iNotes Web Access) server (UNIX system).

5.1.2 Configure Domino domain servers for Sametime

The following steps show you how to enable and configure Sametime on your
Domino server. There are a couple of values in the server document of your
Domino server that you must check and change if necessary.

1. Check the server document of your Sametime server in the Domino domain
for the following entries within the Basic tab:

— Is this a Sametime server?: The value should be Yes.

— Fully qualified Internet host name: The value should be your Sametime
host name, for example: sametime0l.acme.com

2. Assign a Sametime server name to the field “Sametime Server” within the
Administration tab on each user’s person document in the Domino Directory.
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To make sure you enter the hierarchical name of the Sametime server, enter it
with the canonical format: CN=Domino server name/0U=0rgUnit/0=0rg

For example: CN=Sametime01/0U=SRV/0=iNotes

5.1.3 Verify the setup

You can verify that you have performed all the steps correctly and that your
installation is working properly by the following:

1. Make sure that replication has completed and the Person documents exist on
the Directory of your Sametime server with the Sametime server field
populated.

2. (Optional) Test using the Sametime Connect client. Have the user log into the
Sametime server using the Connect client or launch Sametime Connect
directly from the Sametime server home page.

3. Test that Sametime is working within iNotes Web Access by opening iNotes
Web Access in your browser and clicking the Chat button. You should see a
Sametime chat window like the one in Figure 5-2.

; Sametime - Chat - Microsoft Intern... [EJE

lose | Cancel

I Browse... |

Add MNew Group |

|@ 1 am active

Figure 5-2 The Sametime awareness window

5.1.4 Create a buddy list

A buddy list is a list of people the user usually chats with. Before users can start
chatting with other users, they have to set up their own buddy lists. Use the
following steps to set up your buddy lists.
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1. From the Sametime awareness window, click New Group. Enter an
appropriate name and click Add. You can add as many groups as you wish.
Once a group is created, people can be added to it.

3 Add New Group -- Web Page Dialog B3
Please type in a new group nare:
{ms0l
Add Cancel |

Figure 5-3 Add new group dialog

2. To add a user to the buddy list, select the group first.

3. Enter your colleague’s first name, last name, or both in the blank field and
click Add. If the entered name is not unique, all matching names will be
added. To search for and select the user from a directory, click the Browse
button, after entering the name, and the address dialog is opened.

Figure 5-4 shows an example of a buddy list with several groups set up.

; Sametime - Chat - Microsoft Intern... [EJE

Tommi Tuligalo
Leonarde C Vidal
David Marrison

El-&2 That's me
d Roger Zirn
Eak Some other people
Michele Pfeifier
@ Jennifer Lopez

| 1 Am Active

Figure 5-4 Sametime awareness window after adding groups and people

In the lower left corner of the Sametime Chat window you can see your
Sametime status. When the chat window opens it automatically sets you to “l Am
Active.” But sometimes you might want to show other users that you are actually
online but don’t want to chat for some reason. Therefore, the status can be
changed manually by clicking the Sametime status. The following choices are
available:
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| Am Active

| Am Away

Do Not Disturb Me

Log Off from Sametime

vVvyyy

If you choose “Log Off from Sametime” you will get disconnected from the
Sametime server. No status will be shown but the Sametime window will remain
open, unless you specifically close it. To reconnect to Sametime, just click the
Sametime status again and select the only choice available: “Reconnect to
Sametime.”

On the Sametime awareness window, icons show the status of each Sametime
user you have identified in your buddy lists. We have added text to the screen
shown in Figure 5-5 to explain the meanings of the icons.

# Sametime - Chat - Microsoft Intern... [[E] E3

&k TS0
Tormimi Tulisalo  Disconnected
@ Leonardo CVidal 1Am Away
David Marrison
B2 That's me
=@ Roger Zirn 1 Am Active
El&& Some other people
@ Jennifer Lopez Do Not Disturb Me
Michele Pfeiffer

= | Arn Active

Figure 5-5 Sametime status icons

5.1.5 Start chatting

If you want to start chatting with an online user, just double click on the user’s
name on the Sametime window and start writing text. Figure 5-6 on page 111
shows an ongoing Sametime Chat waiting for a response.
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You have the capability to invite other users to participate in an ongoing chat by
clicking Invite Others. To leave a chat, just click the Close button and the
conversation will be terminated.

1 Jennifer Lopez [started: 01-0ct-01] H=l B3

Meeting  Edit

Tupe pour best

Roger Zim/USRAM. . hi jennifer, how are you doing today?

Send

|Waiting far response. ..

|Warning: Applet Window

Figure 5-6 Started Sametime Chat dialog

5.2 Using parts of iNotes Web Access in Web

applications

It is possible to use parts of the iNotes Web Access mail file in other Web
applications. For example, you could have your own portal application, where you
would like to see the mail part of the iNotes Web Access, or there could be an

application where you need to refer to the calendar part only to check for

availability.

The URLs identified in Table 5-1 can be used to access specific parts of iNotes

Web Access.

Table 5-1 Available parts of iNotes Web Access
Page URL (only the end of the URL is shown here)
Mail ....nsf/iNotes/Mail/?OpenDocument&ui=portal
Calendar ...nsf/iNotes/Calendar/?OpenDocument&ui=portal
ToDo ...nsf/iNotes/ToDo/?OpenDocument&ui=portal
Contacts ...nsf/iNotes/Contacts/?OpenDocument&ui=portal
Notebook ...nsf/iNotes/Notebook/?OpenDocument&ui=portal

An example of the selective use of iNotes Web Access follows.

Chapter 5. Integration

111




&} https:/ /caffreys.lotus.com/demo/homepage3.nsf - Microsoft Internet Explorer

J File Edit View Favorkes Tools Help

My cool Portal =

Change content of iMNotes Web Access frame to Mail - Calendar - ToDo - Contacts - Notebook =l

' 1BM Redbooks

B Bluepages Bl search HelpNow

All About
Doming

Welcome..." ™
to the technical resoirce’
for Notes and Domino!
. Redhbooks

Brought to you by the creators of the product
it = Newr @ @
-
| »

-
< [E— o
« iNotesWebAccess. Inbox @ chat @ Praferances  @Halp A
wednesday
IR ORI v - [reply ~ [ Forvard [ Refresh Jwiove - | Mark Read =
02:47PM
V Who Date - Size Subject Go to e ¥
Leonarde C Widal 09/26/2001 937 test off-line 2|
Tabai wiolfgang_Hass  09/24/2001 1569 just another test
Leonarda C widal 0%/18/2001 233051 & Test
Drafts db1 09/17/2001 2082 what's New in GuickPlace dbi
Sent inotes 09/10/2001 1244 You are invited to join 2 QuickPlace: dbl
all Dacurnents
Trazh
4| My Folder
i 1]
& | Internet 7

Figure 5-7 A portal that incorporates the mail part of iNotes Web Access

Figure 5-7 shows a personal portal that incorporates a portion of iNotes Web
Access. The bottom frame is the mail part of iNotes Web Access.

In this example portal we also have links to other individual parts of iNotes Web
Access. They are found in the top frame, where you can click Calendar, ToDo,
Contacts and Notebook to access those parts of the program. The format of the
links was identified in the preceding table. Clicking one of the links will change
the content of the bottom frame.

It is also possible to extend the URL with some arguments to explicitly call a
specific view or folder. The name of the variable is PresetFields, and the
arguments are shown in Table 5-2 on page 113.
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Table 5-2 Arguments for the variable PresetFields

Portal View/Folder Argument (
Mail s_ViewLabel --> Title of view/folder
s_ViewName --> Porgrammatic name
Inbox s_ViewLabel;Inbox,s_ViewName;($Inbox)
Drafts s_ViewLabel;Drafts,s_ViewName;($Drafts)
Sent s_ViewLabel;Sent,s_ViewName;($Sent)
All Documents s_ViewLabel;All Documents,s_ViewName;($All)
Trash s_ViewlLabel;Trash,s_ViewName;($Trash)
Calendar
One Day s_CalView;D
Two Day s_CalView;T
Five Day s_CalView;F
One Week s_CalView;W
Two Week s_CalView;2
Month s_CalView;M
Year s_CalView;Y
ToDo List s_ToDoView;L
Chart s_ToDoView;G

For example, the following URL brings up the Sent view (only the ending part of
the URL is shown here):

....8ui=portal&PresetFields=s ViewlLabel;Sent,s ViewName; ($Sent)

As another example, the following URL example brings up the One Week
calendar view (again, only the ending part of the URL is shown here):

....&ui=portal&PresetFields=s_CalView;W
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Customization of the iNotes
Web Access design

In this chapter we discuss the iNotes Web Access template architecture (from an
abstract point of view) and why it is difficult to customize the design. Yet, there
are some things that can be customized, with a reasonable amount of work. A
couple of examples are covered in this chapter.

This chapter covers the following topics:

>

>

>

Customization considerations
Template architecture

Inheriting from an alternate template
Customization samples

Mail view customization

Customizing existing views or folders
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6.1 Customization considerations

Customizing Domino database templates, including the Standard R5 Mail
templates, is common among many customers and business partners. This has
led to numerous questions regarding what type of customization can be done to
the iNotes Web Access 1.0 mail template.

Some areas of iNotes Web Access were not designed in the Domino Designer.
For this reason, the design resists the customization techniques familiar to
developers who work with other Lotus products.

There is a lot of JavaScript code used in iNotes Web Access. Comments and
meaningful text strings are stripped away from the code to optimize performance
by minimizing the amount of code that needs to be passed to the client side.
Thus it's not necessarily clear what the design elements are, and you're more
likely to break something than to safely add your functionality, and changing
things in Designer may produce unforeseen results. We recommend that you do
not attempt to customize the iNotes Web Access template until the proper
guidelines are made available by Lotus or through Lotus’ professional services
organization.

The iNotes Web Access development team educated personnel from Lotus
Professional Services in the process of making design modifications to the
iNotes Web Access template. Customers can employ Lotus Professional
Services for any design changes that need to be made to the iNotes Web Access
design.

6.1.1 Support policy for customization

116

The following customization disclaimer is an excerpt from the Lotus Knowledge
Base, Document #186361 - What is the Support Policy for Customization of the
iNotes Web Access Mail template?

The Lotus Knowledge Base is on the Lotus Support Web site at:

http://www.lotus.com/home.nsf/welcome/support

“Customization Disclaimer:

The ability to customize iNotes Web Access 1.0 was not one of the design goals
for this release. As such, customized templates are neither certified nor
supported. Standard practice for Lotus Notes Support for customers who open
incidents resulting from a customized template will be to instruct the customer to
revert back to the stock template and see if the problem still occurs. If it does,
Lotus Notes Support will troubleshoot the problem as it exists in the stock
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template (in other words we will not troubleshoot the customized template). If the
problem does not exist in the stock template, Lotus Notes Support shall
recommend the customer remove the modifications and submit an enhancement
request of the desired functionality for the next release.”

Note: The disclaimer includes Forms5.nsf as well, which is the storage for
most of the design of iNotes Web Access.

6.2 Template architecture

The iNotes Web Access template is located in the data directory on your Domino
server. The filename is iNotes5.ntf, the database title is iNotes Mail and C&S,
and the template name is iNotes5. The iNotes Web Access template inherits fully
from the Extended Mail template (Mail50ex.ntf). The Extended Mail template was
designed to allow offline usage of Domino mail with the Web browser.

6.2.1 Additional design elements within iNotes5.ntf

The following is a list of additional elements in the iNotes5.ntf template database.

» 2 Agents to support bidirectional synchronization from the Notes client for the
Personal Address Book and Journal to the iNotes Web Access Contacts and
Notebook areas.

» New views explicitly for iNotes Web Access:
— New Tasks view
— View to support Gantt view
— New Contacts view
— New Notebook view
— View to support the iNotes Web Access TOC (Table of Contents)

» Proxy documents, all having titles (field $TITLE) that begin with “iwa”. These
are new design element types added for iNotes Web Access. This evolved
from QuickPlace’s use of “documents” within their templates. Proxy
documents allow accessing design elements via a ?0OpenDocument URL.

6.2.2 The Forms5.nsf database

All the forms, subforms, and graphics used by iNotes Web Access (except for
certain images in mail views which are either in the Domino icons directory or
within the mail template) reside in a separate database located within the
<domino data>\iNotes\ subdirectory on the server and named Forms5.nsf.
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The reason for keeping design elements in a different single database, instead of
in individual mail databases, is that they can be cached on the server. All the
Web browsers accessing mail files on a server will use the same design
elements, which can be loaded from the server cache. Caching the elements on
the server allows better performance on the server.

Figure 6-1 illustrates the relationships between the databases that form the
iNotes Web Access mail file and the user interface. The data itself is kept on the
mail file, User1.nsf in this case.

<domino data>\ |<domino data>\iNotes\ |

inherits fub

Mail50ex.ntf iNotes5. ntf

data and little
of the design

Figure 6-1 iNotes Web Access template architecture

6.3 Inheriting from an alternate template

If a company has customized the mail template, the best approach might be to
make this customized template be derived from Mail50ex.ntf. The iNotes5.ntf
template can then be modified to inherit fully from this customized template. This
would allow the company to continue to experience the customization which had
been done to the Notes client or WebMail experience. However, most of the
customization will not be viewable or usable with the iNotes Web Access client.
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6.4 Customization examples

Despite the previous warnings, there are some modifications possible which
should not harm the functionality of iNotes Web Access. In this section we
describe a couple of customizations you can do yourself.

6.4.1 Change the iNotes Web Access logo to a custom logo

As installed, iNotes Web Access displays its logo in the upper left of the user’s
screen (see Figure 6-3 on page 120). You can replace the iNotes Web Access
logo with a custom logo using the following steps. An example of a custom logo is
shown in Figure 6-4 on page 121.

1. Open the \iNotes\Forms5.nsf database (below you Domino Data directory) in
Domino Designer.

2. Click the Forms view.
3. Create a new form and give it the following title: Image

4. Create a Rich Text field in this new form and call it anything you want; it's not
important what you name the field.

5. Save the form.

[g}lmage - Form - Lotus Domino Designer

File Edit Yiew Create Design Help {i}@g ﬁ
@ iMotesh Cornmaon Forms - Design - Forms ! Irmage - Form ﬂ des’gﬂe"
’E@j ~ Recent Databases ; |—LQ9~CLELELd—TJ| =
iNotess Common Farr
- C:ALotughiM otes\D ominohDz
@ B Outlines
@) E Frameszets
=" | Pagesz
| Forms
Wigwes
(7 Folders j
4+ Navigators i
§ doene i LogoField [Field) : Default Val
£3 Synopsis.. Objects IReference L OgnE [Field] : Default Value -
[* Resources = = LogoField (Field) «] | Run IFormuIa j
RelD = fault Value
< HTML Attribute
@ onBlur
& onChange
2 onClick
ConDbiClick |
ConFocus
& onkeyDown
O nnkevPre =

_Ii:)efault Sans *10%|[Mane] 3l °| |Office fE=E
Figure 6-2 Image form

6. Open the \iNotes\Forms5.nsf database in a Notes client.

Chapter 6. Customization of the iNotes Web Access design 119



120

7. Click the hResourcesByName view.

8. Search for the entry iwa.gif on this view.
9. Open the document.

10.Double-click to edit the iwa.gif document.

11.Click the iwa.gif attachment and press the Delete key to delete the
attachment.

12.Attach the new logo gif, which must also be named as iwa.gif, into the rich
text field.

13.Save the document.

Important: If you upgrade or reinstall the server code, the Forms5.nsf will be
replaced and your changes will be lost. Make a copy of your customized
Forms5.nsf before upgrading the server and copy your customized elements
back after the update has taken place.

Make sure you've cleared your browser's cache before you open iNotes Web
Access. The new logo should now appear in place of the iNotes Web Access
logo.

If you don’t see the new logo, click the Refresh button on your browser, while
holding the Ctrl key down. This will cause the browser to retrieve all the elements
of the Web page from the server.

Figure 6-3 shows you an iNotes Web Access interface with a standard logo.

42 Mail - Microsoft Internet Explorer

J File Edt M“ew Favartes Tools Help I“
o o @ Logout @ chat @ Go Offine @ Preferences @ Help 2]
?,- iNotesWeb Access.
Roger Zim " Welcome Mail - Calendar -~ To Do List ~ Gontacts -~ Notebook -
Thursday
4 octo4, zoo1 Inbox I @
02:13PM .
Al tew = | Reply ~ | Forward || Refresh ve T Mark Read +
Inbos who Date - Size Subject GO to «®|
B Leonardo © Vidal 0%/26/z001 937 test off-line =]
wolfgang_Hass  0%/24/2001 1562 just another test
Sent Leonardo ¢ Vidal 0%/18/z001 233051 & Test 1
db1 09/17/2001 2032 What's New in QuickPlace dbl
AliseEns inotes 09/10/2001 1244 You are invited to join 3 QuickPlace: dbl
Trazh
4| My Folder
==
|&] Done l_ @_ |4 Treermet 7

Figure 6-3 iNotes Web Access with default logo

After performing the customization steps, you should see results similar to those
shown in Figure 6-4 on page 121.
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42 Mail - Microsoft Internet Explorer
JFiIe Edt Wiew Favorites Tools  Help I“

. @ Logout @ chat @ Go Offine @ Preferences @ Help &)
dann/no
—— -
Roger Zim | Welcome Mail ~ Galendar - To Do List © Gontacts + Motebook -
Thursday
4 octo4, zool Inbox |
02:19PM
V Delete | Mark Read ~
Inbox Date - Subject Go to «t]
Leonardo € Vidal 09/26/2001 test off-line 7y
L=l walfgang_Hass  09/24/2001 just another test B
Sent Leonardo € Vidal 09/18/2001 233051 & Test ]
dbi 09/17/2001 2032 What's New in QuickPlace dbl
AliseEns inotes 09/10/2001 1244 You are invited to join 3 QuickPlace: dbl
Trazh
4 My Folder
==
|&] Done E|Q Inkernet 7

Figure 6-4 iNotes Web Access with custom logo

Note: The size of the logo should not exceed 185x42 pixels. If you use a
bigger logo than this, the layout of the window could be affected.

With this experience you are now able to change other graphics to change the
look and feel of the user interface.

6.4.2 Reordering items within the iNotes Web Access TOC

It is possible to change the order in which the top level items of the Table of
Contents (TOC) are displayed.

2 Mail - Microsoft Internet Explorer
J File Edt “iew Favartes Tools Help I“
3 @ Logout @ chat @ Go offine @ Preferences @) Help =
dannino e, o
Roger Zim Welcome Mail -~ Galendar - To Do List ~ GContacts - NDteETD
Thursdsy =
4 octo4, zoo1 Inbox —_—'— @
02:112PM .
Rl Hew ~ | Reply » | Forward || Refresh | Move = Mark Read -
Taboit who Date = Size Subject GO to «*®
o Leonardo © Vidal 0%/26/z001 337 test off-line 2]
wolfgang_Hass  0%/24/2001 1569 just another test
Sent Leonardo ¢ Vidal 08/18/z001 233051 & Test {1
db1 09/17/2001 2032 What's New in QuickPlace dbl
AlBeEEE inotes 09/10/2001 1244 You are invited o join 3 QuickPlace: dbl
Trazh
4 My Folder
Ei=
|&] Done E|Q Inkernet 7

Figure 6-5 iNotes Web Access TOC in default order
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You can reorder the TOC by changing the value of the h_Position field within the
appropriate proxy document. Proxy documents are new design elements (see
6.2.1, “Additional design elements within iNotes5.ntf” on page 117). Even if they
are visible within views, the values of these documents cannot be changed by
using an appropriate form, nor can the documents be deleted using the delete
key. You can manipulate the values or delete documents by using agents.

Let’s assume you want to have your To Do List in the third and your Contacts in
the fourth position.

To change the TOC order as described, use the following steps (with a very
simple agent).

1.
2.
3.

Open the \iNotes5.ntf template in Domino Designer.
Click the Agents view.

Create a new agent and give it a title, like Change TOC Position. (You can call
it anything you want; it's not important what you name the agent).

Leave the default for “When should this agent run?” set to “Manually from
Actions Menu.”

Leave the default for “Which document(s) should it act on?” set to “Selected
Documents.”

Because the field h_Position is a number field, select “Formula” as the choice
for the Run option, rather than “Simple Action(s).”

. As a simple formula, enter:

newValue := @Prompt( [OkCancelEdit]; "New Position"; "Enter new value for "
+ h_Name; @Text( h_Position ) );
FIELD h_Position := @TextToNumber( newValue )

Save the agent.
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}&> untitled - Agent - Lotus Domino Designer
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LI Scheduls... |

Which document(s) should it act on?
A

I Selected documents
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Action|
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Figure 6-6 Change TOC Position agent

9.

Open the \iNotes5.ntf template in a Notes client as follows: Go to the icon of

the template (either in a Bookmark or on the Workspace) and, while pressing
the Ctrl+Shift keys on the keyboard, right-click the icon with the mouse. Select
Open. The template opens and additionally you can see the hidden views.

10.Click the (HaikuTOC) view.

™ Joe shimmer - (HaikuTOC) - Lotus Notes

[_ O[]
Flle Edit View Create Actions Help ¢ } x}’l\l‘ G
CGEL By A LT F6 5 & == o @
‘Workspace !@Jna Shlmmar—(HalkuTOC}ﬂ notes
h Position | Title |h Type |h URLpointer h URLMewWindow $AutoE ditMade h Unid
e - 10000 Welcome | 4DF38292074806900!
15000 Wil 1 52482AZ0E0EECEEES,
= e o000 Calendar 1 2A822040C75DDO0EL
= T 550000 ToDolist 1 08AA2D521BAFE 7568
=l (HakuTeckstl) 600000 Contacts 1 FAJ5E514B4DFAI040
[HaikuTOE) 700000 Motehook 1 ID9BTARERD47ICETE
[Motes)
[MatesContacts)
[MotesToDa)
[mapiStationery]

AlleDoks

‘|=3[Boston |

Figure 6-7 View (HaikuTOC) with default order
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11.Select the document(s) you want to change. For our example, select To Do
List and Contacts.

12.Select Actions -> Change TOC Position (or the name of the agent you just
created in step 3) and you will be asked to enter new values for each selected
document. Enter 200000 for To Do List and 300000 for Contacts. The
documents will then appear in the new order.

£% Joe shimmer - (HaikuTOC) - Lotus Notes [_ O]
Fle Edt View Create Actions Help & 5 a9 G
CEL DA A EF £ 4 0 F 2 o%= S ak
Warkspace !@JneShimmer-(Ha\kuTOC)ﬂ notes
e h_Position | Title 'h_Type |h_URLpointer [h_URLNewWindow| $AutoE ditode [h_Unid
o — [10000 Welcome 1 4DF38232D74806400!
i [W:mf] 1500 [ 52482AZ050EBCE5EE
Fi Wl <2mnnm ToDo List ™~ 1 08AA2DE21 BAFE 7568
el = S 300000 Contacts 1 FASEE614B4DFAINA0
&1 S (HakuT skl 40000 Sendar 1 24322048C75DD00BL
2 700000 Notebook 1 ID9B1ARERDAPICATE
i | El (iNotes)
[MotesContacts]
[NotesTaDo)
[mapiStationen)
AlleDoks
| Hi | 7 /=2 Boston =]

Figure 6-8 View (HaikuTOC) after reordering

13.Refresh or replace the design of a specific mail file manually, or do it for all
mail files with a server task. You can use the convert server task to do this.
For instructions, see 3.4.3, “Converting mail files to iNotes Web Access” on
page 58, or the section “Upgrading users’s mail files” in the Domino 5
Administration Help database (help5_admin.nsf).

42 Mail - Microsoft Internet Explorer

JFlIe Edit Wiew Favorites Tools Help

@ Logout @ chat @ Go Offline @ Preferences @ Help &
Lotus.
Roger Zim [ welcome Mail -(Jo Do List ©~ Contacts -)Calendar < Motebook -~
Friday
5 octos, zoow Inbox | @
10:194M
B WW Forward | R Move = [ Delete | Mark Read
Inbox Who Date - Size Subject GO to -*k
i Leonardo © Vidal 09/26/2001 337 tast off-line =]
Wolfgang_Hass  09/24/2001 1569 just another test
Sent Leonards C Vidsl 09/18/2001 233051 & Tast 1
dbl 09/17/2001 2032 What's New in QuickPlace dbl
Cll i i inotes 09/10/2001 1244 You are invited o join 2 QuickPlace: dbl
Trazh
|+ My Folder
==
|&] Done E|e Inkernet %

Figure 6-9 iNotes Web Access TOC after reordering
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6.4.3 Disabling the Welcome page from the iNotes Web Access TOC

If a company doesn’t want their users to access the Welcome page, there is a
simple way to remove this entry from the iNotes Web Access TOC.

Use the following steps to disable the Welcome page.

1. Open the \iNotes5.ntf template in Domino Designer.

2. Click the Agents view.

3. Create a new agent and give it a title, like Delete Document (You can call it
anything you want; it's not important what you name the agent).

4. Leave the default for “When should this agent run?” set to “Manually from
Actions Menu.”

5. Leave the default for “Which document(s) should it act on?” set to “Selected
Documents.”

6. Leave “Simple action(s)” as the choice for the Run option.
7. Click Add Action and select “Delete from Database” as the Action. Click OK.
8. Save the agent.

[f:l:hange TOC Position - Agent - Lotus Domino Designer

File Edit Wew Create Actions Help ﬁ} @ g %
@ @ iMotes hail and C&S - Agents | @ Change TOG Position - Agent ﬂ d’esigner
EE’] - Recent Da g Name: IDeIete Document Options... |
e ¥ SharedSoent
Za2) iNates Ma @ ‘when should this agent mn?
| 4 CihLatushite IManuaIIy From &ctions Menu LI Schedule.. |
§ B Outlines
L?}‘; [H Framesets @ which document(s) should it act on?
| ] Pages ISeIected documents 4|
| Forms
| isivs Add Search... |
£ Falders
-+- Mavigators
| () doents
| Sinopsis... _Delete Document [Agent] : Action - |
| [* Rezources Run ISimpIe achion(z) j
iNotesh Ci J
C:ALotushiMe
Edit Action... |

I i | “<0affice
Figure 6-10 Delete document agent

9. Open the \iNotes5.ntf template in a Notes client as follows: Go to the icon of
the template (either in a Bookmark or on the Workspace) and, while pressing
the Ctrl+Shift keys on the keyboard, right-click the icon with the mouse. Select
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Open. Now you can release the Ctrl+Shift keys. The template opens and

additionally you will see the hidden views.
10.Click on the (HaikuTOC) view.

See Figure 6-7 on page 123 for the default view order containing the

Welcome Page document.

Note: Make sure you make a backup copy of the inotes5.ntf database before
proceeding further. After you have deleted the documents, as instructed by the
following steps, you can not undo that. If you need to get the documents back,

you can use your backup copy.

11.Select the document with the title Welcome.

12.Select Actions -> Delete Document (or the name of the agent you just

created in step 3) and the document disappears from the view.

£ Joe Shimmer - (HaikuTOC) - Lotus Notes =]
Fle Edi ¥ew Create Actions Help e v G ©

QEA N 29 EF 00 28 ¢ -%= Sal

Warkspace !@ Jae Shimmer - (HaikuTOC) i‘ notes

h_Position | Title 'h_Type |h_URLpointer [h_URLNewWindow| $AutoE ditode [h_Unid
T - [15000 Wil 52482AZD50EBCH5ES
. e 400000 Calendar [ 24822048 750D006L
= Wl 550000 ToDolist 1 18AA2D521 BAFE 7668
o v 600000 Contacts 1 FAS5E614BADFAI040
El (HaikuT asksAl) 200000 Notebook 1 3D9B1ASEEDA7ICE £
El (iMotes)

Bl [NotesContacts)
=1 [MNotesTaDo) il
[mapiStationen)
=1 AlleDioks

Joe S himmer

S

=2 Baston =]

Figure 6-11 View (HaikuTOC) after deleting the ‘Welcome Page’ document

13.Refresh or replace the design of a specific mail file manually, or do it for all
mail files with a server task. You can use the convert server task to do this.
For instructions, see 3.4.3, “Converting mail files to iNotes Web Access” on
page 58, or the section “Upgrading users’s mail files” in the Domino 5

Administration Help database (help5_admin.nsf).
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42 Mail - Microsoft Internet Explorer
J File Edt M“ew Favartes Tools Help I“
. @ Logout (@ Go Offline @ Preferences @ Help A
dann/no
Joe Shimmer " Mail ~ calendar - To Do List © Contacts - MNotebook
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4 Hov o4, zool Inbox I @
20156 =
Rl Hew ~ | Reply » | Forward || Refresh | Move = Mark Read -
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B RZIRN 29082001 424 Resource Reservation Request 2]
Joe Shimmer 18,07,2001 867 Links
Sent Roger Zirn 15.03,2001 118525 & Mail mit Notes Client o)
Al D inte Roger Zitn 15.03,2001 113554 & Mail mit Notes Client
Roger Zitn 15.03,2001 5375552 & Mail mit Motes Client
Trazh Siwilliamm Outlook  13.02,2001 3026 Test
4| Hew Falderd williarm Outlook  13.03,2001 2823 RE: Info diber iMotas
==
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Figure 6-12 iNotes Web Access without Welcome within TOC

When the user accesses the mail file with a URL like:

http://hostname/mail/filename.nsf?0penDatabase

iNotes Web Access redirects the user to a URL like”

http://hostname/mail/filename.nsf/iNotes/Mail/?0penDocument&ui=inotes

Notice the Mai1 part of the URL instead of Welcome. iNotes Web Access uses the
first document in the (HaikuTOC) view to redirect the user. Furthermore, if you
also delete the Mail document from that view, you are redirected to the To Do List
when accessing the mail file.

6.5 Mail view customization

You can add new views or modify existing ones. Refer to 6.3, “Inheriting from an
alternate template” on page 118 for considerations about where to do these
customizations. We don’t recommend customizing iNotes5.ntf for the following
modifications.

iNotes Web Access gets its mail views from the outline called WebMailOutline.
Apart from the Address Book, Discussion and Rules entries, which are for
WebMail only, all views are displayed within the mail view navigator.

6.5.1 Addition of new views

If a view is added and enabled for the Web, it should be displayed just below the
default views and any folders that have been added within the iNotes Web
Access’ mail view navigator as well.
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Note: iNotes Web Access’ virtual list component does not support hierarchical
views, but supports views with categorized columns, which have the
Categorized is flat version 5 or greater sort column property set.

42 Mail - Microsoft Internet Explorer
J File Edt M“ew Favartes Tools Help
. @ Logout @ Go Offline @ Preferences @ Help A
dannino
Joe Shimmer [ welcome Mail ~ calendar - To Do List ~ Gontacts ~ Notebook -
Sunday =
4 Hov o4, zoo1 Inbox I @
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B RZIRN 29.082001 424 Resource Reservation Request ]
Joe Shimmer 12,07,2001 867 Links
Sent | Roger Zitn 15.03.2001 118525 & Mail mit Notes Client
el D Roger Zirm 15.032001 113554 & Mail mit Notes Client
Roger Zitn 15.03,2001 5375552 & Mail mit Notes Client
Trazh Sywilliamm ©utlook  13,02,2001 3026 Test
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Hew View3 | LILI
|&] Done | Treermet 7

Figure 6-13 Mail navigator with new views

If you want to have the new views listed in an order other than the default, you
need to customize the outline called WebMailOutline.

To add a new view, use the following steps.

1. Open the appropriate template in Domino Designer.

Click the Outlines view.

Open the WebMailOutline.

Create a new entry at the desired position.

o kM DN

For the content, select a named element and the new view.
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Figure 6-14 New views within WebMailOutline

6. Save the outline.
7. Refresh the design.

iNotes Web Access should display the mail views in the new order.
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Figure 6-15

iNotes Web Access mail views in new order
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6.5.2 Customization of existing views or folders

For mail views, iNotes Web Access’ virtual list component should be able to
handle adding new columns, or changes to formulas used for the various
columns, as well as changes to selection formulas for any of the views. iNotes
Web Access calendar views only look within specific programmatic named
columns and will not do anything with any additional columns which may be
added.

The following figure shows a changed Sent view with reordered columns, and a
new column, Size added.

42 Mail - Microsoft Internet Explorer
JFlIe Edit Wiew Favorites Tools  Help

-

. Logout Go Offline Preferences Help
darrn/no - — ~ =
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111,02,2001 william Outlook 701 Info Ober iNotes

Sent | 13032001 william Outlook 10931 & RE: Info iiber iNotes
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Figure 6-16 Modified Sent view
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Troubleshooting

In this chapter we identify some sources you can turn to for help when installing
and running iNotes Web Access. We also discuss some basic troubleshooting
techniques which might be helpful if you encounter problems.

This chapter contains the following:

» Places to look for information

» Troubleshooting information

» DOLS troubleshooting
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7.1 Sources of helpful information

There are several sources of helpful information available, depending on your
needs. This section identifies some of them.

7.1.1 Release notes: Domino/Notes 5.x.x

The Notes database is located in <yourdata>\help\readme.nsf for both Domino
server and Notes client. Among other useful information, like What’s new or SPR
tracking, there is a document called Troubleshooting the Domino server for
iNotes Web Access.

After opening the Database, select Troubleshooting on the left navigator.

Within the Server category, expand the iNotes Web Access sub-category. Here
you'’ll find the document.

£ Release Notes:Domino/Notes 5.0.8 - a. Contents’.c. Troubleshooting - Lotus Notes
File Edit Wiew Create Actions Help

T — +* . ==
CES B £ TFT £ ¢ 8 2=%= %l
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| |T|ouh|eshonling

¥ Administrator Client
b Client
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¥ Server
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b DOLS lssues

b Domino &pplets

Troubleshooting

b General lssues
b iMates Access for Dutlook
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[@ ......Troubleshaoting the Doming server far iNotes Web Access
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b Mail lssues

F Networking |ssues
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F Security |zsues

b Server lssues

b Upgrade |ssues

| | Al *|=2|Boston ||

Figure 7-1 Troubleshooting view in the Release Notes database
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7.1.2 Lotus Knowledge Base

To get the latest information on bugs/problems with iNotes Web Access, visit the
Lotus Knowledge Base at:

http://support.lotus.com

The easiest way to get all documents related to iNotes Web Access is to Search
by keyword.

— Just enter "iNotes Web Access" as the search string (including the double
quotes)

— Make sure Lotus Knowledge Base is selected.
— Click Go and check out the search results.

3 Lotus Support - Microsoft Internet Explorer [1o[=]

JFiIe Edit VWiew Favorites Tools Help ‘
J'Address I@ hkkp: { fwmvs. lokus . comfhome . nsfiwelcome/ support: :J .’[’?Gn

Support  Downleads  Howto Buy  Register

Home Products Services Education Hews & Views Events About Lotus
Search Search the Lotus Knowledge E_lase by_category or keyword, or learn

about our full range of self service offerings and premium services. For

additional support information, refer to our product pages.

Search by category or Search hy keyword

Select by category for product Type one or more words or type a -Read the new issue of s Today
support phrase surrounded by quotes. For

example; "SMTP Mail"

(Seectone M CJrinoren < woens T
Gol [
Search I (| s Knowledge Base

7 Support Downloads
Searsh aptions
Resources

In an engoing effort to improve customer satisfaction the search - Lotus Developer Metwork
links above will soon be replaced with a link to |[BM Software » Lotus [T Central
Support Search.

-+ Motes. net

- Lotus Education

- Business Pattners
+ Lotus Beta Program

3|
r’ r"@ Inkernet /ﬁ

Figure 7-2 Lotus Support Home page

7.1.3 Fix List

There is a Fix List Database on Notes.net where you can look for implemented,
planned, or coming fixes for all Notes/Domino 5 releases. The URL is:

http://www.notes.net/r5fixlist.nsf
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Enter the database and select the view by Prod. area. Expand the iNotes Web
Access category to see all related fixes. Another interesting view to check out is
by Release. There you see the list of fixes categorized by release, in descending
order.

-3} Notes.net: Fixes by Product area - Microsoft Internet Explorer

J Fle Edit ‘ew Favorites Tools Help

Notes:e*

SEARCH VIEWS
I— by SPR | by Release | by Tech. area | by Date mod. | by Plat. | by Prod. area
Gal Advanced * Expand = Collapse = Previous e U

MR/MU STATUS Fixes by Product area

SPR Number Description
1097 b Server
2 b QuickPlace
2481 b Other

HELP

Using this database
Read release notes

MEAAY installers 22 *iNotes Web Access
SANIWACCY  Fixed an issue where performing a search over

SecIAl R : the web in a mail file based on a 4.6% web mail
Regressions ficed in... template and having maximum entries selected
Eearessions identified {500 in...
i 1 : : i :

: DLIUAXFDAS  Fixed a problern with resetting alarrns. Prior to
Iemplate fixes this fix the alarm was still on after turming it off

Fixes listed for

printing ! FIHGATGSYM Wyhen forwarding a docurment in which an

irmage is inserted, if the image is deleted from
the body field, it is still stored in the document
asarn...

' JCIKAYCGAG  Preferences Save & Close fails if port number
in TCRIP_TCRIPAddress is anything other than
1352, This problem has been fixed in...

' MMWHNARCWWAP Remaoved the option to add or remove a
checkmark once a "to do” has heen saved,
fram within the "Set Repeat” hox

l&] ,_,_ |4 Internet

Figure 7-3 Fix List database on Notes.net

S

7.2 Troubleshooting issues

This section contains information on how to solve some of the common problems
with iNotes Web Access.

7.2.1 Damaged Welcome page

As described in 3.8, “Welcome page” on page 75, you can define a URL as a
default Welcome page for iNotes Web Access.
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As with Domino 5.0.9, you have to be careful which characters you’re using for
the title. For example, the use of an apostrophe or single quotation mark causes
the browser to show almost an empty page. With an IE browser version below
5.5 you'll have to confirm lots of JavaScript errors.

The following figure shows how the Welcome page looks with IE 5.5 if you use an
apostrophe or single quotation marks within a title, for example That’s the hottest

Web site.

a Welcome - Microsoft Internet Explorer [_ o]

J File Edit Wiew Favorites Tools Help
-
B

| One moment, please . . . |

=
!@ Cone ’7’7“ Inkernet 7

Figure 7-4 iNotes Web Access with a damaged Welcome page

Resetting Welcome page settings

A URL of the following format may be used to reset your Welcome page settings
to use the default settings:

http://hostname/mail/filename.nsf/iNotes/Welcome/?0penDocument&default

7.2.2 iNotes Web Access user interface not shown

On some occasions, users keep on seeing the user interface of WebMail
although they are already iNotes Web Access users.
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The selected user interface, WebMail or iNotes Web Access, is shown until the
user specifically calls the other user interface by the URL for the first time. After
this, the specified user interface will be used.

Opening the malil file without the &ui= parameter will result in the user interface
being iNotes Web Access.

In case you see the wrong user interface, use the following URLs to change the

user interface to the desired one.

» iNotes Web Access user interface
http://www.acme.com/mail/jsmith.nsf?0penDatabase&ui=inotes

» Domino WebMail user interface

http://www.acme.com/mail/jsmith.nsf?0penDatabase&ui=webmail

7.2.3 iNotes Sync Manager incorrectly prompts for master password

Upon launching, the iNotes Sync Manager prompts for the Master Password
even though the Master Password has not been set (Figure 7-5).

This behavior occurs if DOLConfig.NSF is missing or damaged. A missing
DOLConfig.NSF could be the result of an incomplete install. The solution is to
uninstall and reinstall iNotes Sync Manager. Please refer to chapter 3 section 4.,
“Uninstall Domino Offline Services (DOLS) client software, also known as “Lotus
iNotes.”™ on page 73.

If the uninstall utility does not function properly due to the incomplete install,
follow the instructions in Lotus Knowledge Base technical note #186370 - “How
to Manually Uninstall iNotes Sync Manager”.

Lotus iNotes Sync Manager

Flease provide the master password for activating the Sync Manager:

Password I

Figure 7-5 Lotus iNotes Sync Manager Password
7.2.4 Lotus iNotes installer error

When you attempt to download a subscription of your mail using Internet
Explorer, the following error message on Figure 7-6 occurs:
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i Lotus iNotes Installer . X

Unable to download subscription component infarmation For
http:ffitsokds2. lotus comfdownload filesets{n_DOLBASE inf

Figure 7-6 Lotus iNotes installer error

Perform DOLS Checklist in the server. See chapter 3 Section E, “Checklist -
DOLS installation” on page 64.

7.2.5 Warning message in log.nsf database

The warning message below appears every time a user attempts to download a
subscription from the server and a Security Policy is not found for the
user/domain. The system uses the default behavior, prompting end-users to
provide ID files when going off-line.

Example 7-1 DOLS Warning message on log.nsf

09/28/2001 03:48:10 PM DOLS DSAPI Warning: Unable to find Offline Security
document for user/domain Leonardo C Vidal/USR/INOTES or its parent.

To avoid this message appearing on your server console, you need to create an
Offline Security document in the Offline Services database (dolsadmin.nsf). See
detailed instructions in 3.5.2, “Deploying iNotes Web Access for offline users
using DOLS” on page 60.

7.2.6 Unable to synchronize the mail file

In some cases, you may encounter problems synchronizing your mail file with
DOLS. You might see this happen when you are trying to accomplish
synchronization from outside the firewall.

As part of the initial setup of the Lotus iNotes Sync Manager, an offline database
called dolnames.nsf is created on the user's workstation. By default, it is created
on the C:\Program Files\Lotus iNotes\DATA directory. This database contains a
connection document for the server and this document contains an “Optional
Network Address” field. This field should contain a host name. You can see this
in Figure 7-7 on page 138.

Chapter 7. Troubleshooting 137



£ Connection for: Leonardo Yidal/USR/INOTES - Lotus Notes

File Edit Yiew Create Actions Help x$ ;y &; W\')\ @
GEABOR AD EF 0 08 BOWE
@W’elcome 1l Offline Address Baok - ServeriCannec.. |u Connection for: Leonardo VidallJSRIMOTES ﬂ nofes

z Edit Connection
SERVER CONNECTION: Leonardo Vidaljl

Bazics l Replication/Rauting I Schedule l Comments l Administration |

Connection type: Local Area Metwork Usage priority: Mormal

Source server Leonardo Vidal/USRANOTES Destination server Riol/SEV/NOTES
Source domain: Destination domain:

Uze the port(z]): DOLS_TCRIP Optional network, addresz:  riol. lotuz.com

| 49 = “|S2|CaM_IBM €

Figure 7-7 Connection document

However, if the notes.ini file of the Domino server contains a
“TCPIP_TCPIPAddress=" parameter (one of the options when using Domino
partitioned servers to assign a separate IP address for each partitioned server),
Lotus iNotes Sync Manager installation puts the IP address specified in that
parameter (instead of the hostname) in that field of the Connection document in
dolnames.nsf database.

If the clients are outside the firewall, that IP address cannot be resolved, and
DOLS synchronization fails.

To work around the issue, use one of the following options:

1. In the notes.ini file of the Domino server, change the value of the line
“TCPIP_TCPIPAddress” from an IP Address to a host name, so that the
offline Server Connection document is populated with the host name.

Restriction: For this to work, you cannot use the name TCPIP as a port name
on your server. Use other port names for your actual functioning TCP/IP ports.

2. Manually open the Offline Address book (dolnames.nsf) with a Notes client.
Change the Optional Network Address field contents from the IP address to
the hostname. Using the hostname is recommended, as this will not have to
be changed in the server's IP address changes.

iNotes Web Access Deployment and Administration



iINotes Web Access feature

comparison

The tables on this appendix compare major features of Domino WebMail, Lotus
Notes and iNotes Web Access in several areas. Tables are up-to-date to Domino
Release 5.0.9. If you are using a newer release of Domino, see the following URL

for an updated version of the table:

http://www.notes.net/inoteswebaccesswelcome.nsf/9ef083dbccld1lc5c8525695b0050¢56
4/c90f95eaeee7d5738525697e00605a76?0penDocument

Table A-1  Mail

Feature Webmail iNotes Web | Notes
Access

Views and Folders

In-box view Yes Yes Yes
Drafts View Yes Yes Yes
All Documents View Yes Yes Yes
Discussion Thread View Yes No Yes
Folders Yes Yes Yes
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Feature Webmail iNotes Web | Notes
Access
Nested Folders Yes Yes Yes
Create and delete folders Yes Yes Yes
Drag & drop messages into folders No No Yes
Copy & Move to folder Yes Yes Yes
From the action bar, open mail into specific | No Yes No
view (i.e. inbox, sent, drafts, etc.)
Message Creation and Addressing
Create New Memo Yes Yes Yes
Type-ahead addressing No No, similar Yes
results
achieved by
automatic
name
resolution
Support File Attachments Yes (limitof | Yes Yes
2)
View file attachments form within message | No No Yes
Spell checking No Yes Yes
Alternate Name Support No Yes Yes
Sametime Integration No Yes Yes
Perform Name & Address Book lookup Yes Yes Yes
Display contacts sorted by organizational Yes Yes Yes
unit
Perform Integrated Address book lookup No No Yes
when sending a message
Personal Contacts Address book Yes Yes Yes
Delivery Options (Importance, Delivery Yes Yes Yes
priority, delivery report)
Forward message Yes Yes Yes
Save Message Draft Yes Yes Yes
Create a Serial Route Memo No No Yes
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Feature Webmail iNotes Web | Notes
Access

Forward web pages and documents from No No Yes

any Notes application

Forward document as bookmark link No No Yes

message

"Copy Into" - convert item to Task, Calendar | Yes No Yes

Entry or New Memo

Return Receipt Yes Yes Yes

Prevent Copying No No Yes

Apply Mood Stamps to messages No No Yes

Create/use stationary No No Yes

Choose a Letterhead No No Yes

Create a message containing a signature Yes Yes Yes

file

Type-ahead within “Move to Folder” dialog No No Yes

Specify outbound message with a “reply No No Yes

by” date

Specify message expiration date No No Yes

Internet Message format Yes Yes Yes

Viewing and Responding to Message items

Support for Read/Unread marks No Yes Yes

Navigate to next document without Yes No Yes

returning to view

Perform mail file delegation Yes Yes Yes

Reply w/ history Yes Yes Yes

Reply to memo Yes Yes Yes

Reply to All Yes Yes Yes

Detach Attachments Yes Yes Yes

View Rich text within a message Yes Yes Yes
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Feature Webmail iNotes Web | Notes
Access
Support for Doc Links, View Links, and Yes, onthe | Yes, onthe Yes
Database Links same same server
serveronly | only
View tables within messages Yes Yes Yes
Create tables within messages No No Yes
Resend documents from Yes Yes Yes
View sections Yes Yes Yes
Action Bar Yes Yes Yes
Add Sender of message to Personal Yes Yes Yes
Contacts List
Modify/View the file’s ACL from client No No Yes
Display of Importance/Type icons in Views | Yes Yes Yes
Read encrypted mail and verify signature of | No No Yes
signed mail
Preference setting for new mail on No Yes No
top/bottom
Automatically checking for new messages No Yes Yes
Advanced Editing features in Rich Text field
Left, Right & Center, indent, outdent text Yes Yes Yes
justification
Tables No No Yes
Sections No No Yes
Support for embedded OLE objects No No Yes
Java applet support No No Yes
Page break No No Yes
Horizontal line No No Yes
Hotspots No No Yes
Insert image resources No Yes Yes
Create Sections No No Yes
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Feature Webmail iNotes Web | Notes
Access

Ability to switch language dictionaries for No Yes No

spell checking

Support for both Bullets and number lists Yes Yes Yes

Undo No No Yes

User Preferences

New mail notification No Yes Yes

Default Mail Send/Save setting No Yes Yes

Ability to archive mail and C&S documents | No Yes Yes

Lookup across multiple Address Books Yes Yes Yes

Automatically create a reply message by No Yes No

clicking on the Form field

Security

Send signed and/or encrypted mail No No Yes

Field, form, view, document, section level No No Yes

security

User roles No No Yes

Local Encryption of Mail database No Yes Yes

Other Features

Control of Database properties/design No No Yes

(refresh, replace, etc.)

Support for alternate editors for mail No No Yes

messages

Built-in news reader, POP mail, IMAP mail | No No Yes

Support for Notes/Domino database No No Yes

subscriptions

Extended Search (w/in databases, No No Yes

attachments, messages, etc.)

control of search - refinement of search

with form, etc.

Drag and drop documents between frames | No No Yes
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Feature Webmail iNotes Web | Notes
Access

User can change their own password from | No Yes Yes

client

Table A-2 To Do’s

Feature Webmail iNotes Web | Notes
Access

Option to have To Do’s follow day-to-day in | No Yes Yes

calendar view

Display To Do in Calendar view Yes Yes Yes

Delegate a To Do to another person Yes No Yes

Create To Do's (With Start and End Dates) | Yes Yes Yes

Categorize new To Do entries Yes Yes Yes

Alarm notification on To Do’s No Yes Yes

Mark To Do's complete or uncompleted Yes Yes Yes

Create Group To Do Yes No Yes

Ability to set time on To Do’s No No Yes

Display To Do's in Gantt chart form No Yes No

Priorities for To Do’s (High, Medium, and Yes Yes Yes

Low)

Create personal To Do’s Yes Yes Yes

Owner and Participant actions Yes No Yes
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Table A-3 Calendaring and Scheduling

Feature Webmail iNotes Web | Notes
Access

Views

From the Action bar, open Calendar into No Yes No

specific view (i.e., 1 day, 1 week, 1 month,

etc.)

Calendar Views 1 day 1 day 1 day
2 day 2 day 2 day
1 week 5 day 5 day
2 week 1 week 1 week
1 month 2 week 2 week
1 year 1 month 1 month

1 year

Meeting view Yes No Yes

Calendar Print Preview No Yes No

Work/non-work hour differentiation No Yes No

Ability for Chairperson to see status of No No Yes

invitees from the view level

Calendar Entries and Group Scheduling

Double-click within the calendar view to No Yes Yes

create an entry

Create Appointment Yes Yes Yes

Create All Day Event Yes Yes Yes

Create Reminder Yes Yes Yes

Create Anniversary Yes Yes Yes

Create Meeting Invitation Yes Yes Yes

Create rich text in detailed description field | No Yes Yes

Automatic date (calendar picture) andtime | No Yes Yes

selector controls

Centrally managed rooms and resources Yes Yes Yes

Create repeating entries Yes Yes Yes

Add alarms to entries No Yes Yes
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Feature Webmail iNotes Web | Notes
Access
Attach a file to invitation forms No Yes Yes
Pencil in a meeting / tentatively schedule Yes No Yes
Mark an entry private / “not for public Yes Yes Yes
viewing”
Delivery options on calendar entries Yes No Yes
Address lookup for inviting people Yes Yes Yes
Check free time availability for invitees Yes Yes Yes
Free time search within a counter-proposal | No No Yes
Respond with comments within a No Yes Yes
counter-proposal
Edit calendar entries Yes Yes Yes
Send a reschedule notice Yes Yes Yes
Add additional invitees after invitation is Yes Yes Yes
sent
Send “broadcast” invitation (no Yes Yes Yes
RSVPs/responses)
Send meeting confirmation Yes Yes Yes
Display invitee responses in invitation Yes No Yes
Accept invitation Yes Yes Yes
Decline invitation Yes Yes Yes
Counter propose an alternative time Yes Yes Yes
Accept/decline with comments No Yes Yes
Delegate an invitation Yes No Yes
Check calendar from invitation page No Yes Yes
Create and maintain group calendar No Yes Yes
Create meeting invitation from group No Yes No
calendar view populating group members
in invitation
Accept counter proposal Yes Yes Yes
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Feature Webmail iNotes Web | Notes
Access

Users in different time zones can share the | No Yes Yes

same server and still see meeting times

with respect to their own zone

User Preferences

Set global default appointment duration Yes Yes Yes

Set global default calendar entry type No Yes Yes

Option to make free time available to only | Yes Yes Yes

certain users

Options to set allowable free time Yes Yes Yes

Enable conflict checking for calendar No Yes Yes

entries

Allow another user to manage Calendar Yes Yes Yes

without allowing access to e-mail

Mark default calendar entry as “not for No Yes Yes

public viewing”

Autoprocessing of Calendar information

Option to remove invitations from Inbox Yes Yes Yes

after processing

Ability to autoprocess invitations Yes Yes Yes
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Table A-4 Personal Contacts

Feature Webmail iNotes Web | Notes
Access
Sort contacts by Last Name, Company, Yes Yes Yes
e-mail, Address, etc.
Add users in Domino Directory to Personal | Yes Yes Yes
contact list
Select multiple contacts and send No Yes Yes
message
Select multiple contacts and schedule a No Yes Yes
meeting
Business Card Summary view No Yes Yes
Categorization of contacts Yes Yes Yes
Automatically add e-mail sender to Yes No Yes
Personal contact list
Table A-5 Attachments
Feature Webmail iNotes Web Notes
Access
Unlimited Attachments No Yes Yes
(Maximum 2)
Drag and drop attachments from No Yes Yes
desktop/file system
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Table A-6 Miscellaneous

Feature Webmail iNotes Web | Notes
Access
Browser Support Internet Internet N/A
Explorer 4.x Explorer 5.x
Internet
Explorer 5.x
Netscape
Navigator 4.x
Advanced Search (contextual by text, No Yes Yes
author, or date)
Journal integrated in mail file No Yes No
Contacts integrated in mail file Yes Yes No
Ability to snooze alarms across No Yes No
multiple sessions/logins
Context sensitive help No Yes Yes
Offline support for Messaging, PIMand | Mail only Messaging Yes
Collaborative Applications PIM
Welcome Page Support No Yes Yes
Mail view filter for unread messages No Yes No
Mail view filter for high priority No Yes No
messages
Mail view filter for last 10 messages No Yes No

Appendix A. iNotes Web Access feature comparison

149



150  iNotes Deployment and Administration



Additional material

This redbook refers to additional material that can be downloaded from the
Internet as described in the following sections.

Locating the Web material

The Web material associated with this redbook is available in softcopy on the
Internet from the IBM Redbooks Web server. Point your Web browser to:

ftp://www.redbooks.ibm.com/redbooks/SG246518.z1ip

Alternatively, you can go to the IBM Redbooks Web site at:

ibm.com/redbooks

Select the Additional materials and open the directory that corresponds with
the redbook form number.
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Using the Web material
The additional Web material that accompanies this redbook includes the
following files:

File name Description
$G246518.zip Zipped sample database containing design elements
used in the user migration example.

System requirements for downloading the Web material

The following system configuration is recommended:
Operating System: Windows/32

Processor: Any
Memory: Any
How to use the Web material

Create a subdirectory (folder) on your workstation, and unzip the contents of the
Web material zip file into this folder.
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Related publications

The publications listed in this section are considered particularly suitable for a
more detailed discussion of the topics covered in this redbook.

IBM Redbooks

For information on ordering these publications, see “How to get IBM Redbooks”
on page 154.

>

Lotus Notes and Domino Take Center Stage: Upgrading from R4 to R5,
SG24-5630

Lotus Notes and Domino R5.0 Security Infrastructure Revealed, SG24-5341
Lotus Sametime 2.0 Deployment Guide, SG24-6206

Lotus Domino R5 for Sun Solaris, SG24-5969

Lotus Mobile and Wireless Solutions, SG24-6525

Lotus Domino for S/390 Release 5: Performance Tuning and Capacity
Planning, SG24-5149

Other resources

Lotus Domino R5 Administration Help, help5_admin.nsf

These Lotus Whitepaper publications, available from the Lotus Web site, are also
relevant as further information sources:

>

iNotes Web Access Deployment Guide

» Best Practices Guide Maximum Performance at Minimum Expense:

Optimizing Your Current Domino Applications and Server Platforms

» Domino R5 Performance and Scalability

Referenced Web sites

These Web sites are also relevant as further information sources:

» Lotus iNotes product page

http://www.lotus.com/home.nsf/welcome/inotes
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» Notes.Net iNotes Web Access page

http://www.notes.net/inoteswebaccesswelcome.nsf

How to get IBM Redbooks

Search for additional Redbooks or Redpieces, view, download, or order hardcopy
from the Redbooks Web site:
ibm.com/redbooks

Also download additional materials (code samples or diskette/CD-ROM images)
from this Redbooks site.

Redpieces are Redbooks in progress; not all Redbooks become Redpieces and
sometimes just a few chapters will be published this way. The intent is to get the
information out much quicker than the formal publishing process allows.

IBM Redbooks collections

Redbooks are also available on CD-ROMs. Click the CD-ROMSs button on the
Redbooks Web site for information about all the CD-ROMs offered, as well as
updates and formats.
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Special notices

This publication is intented to help server administrators deploying iNotes Web
Access to understand how to best install, deploy and configure iNotes Web
Access for their own environment. The information in this publication is not
intended as the specification of any programming interfaces that are provided by
the iNotes Web Access product.i

References in this publication to IBM products, programs or services do not imply
that IBM intends to make these available in all countries in which IBM operates.

Any reference to an IBM product, program, or service is not intended to state or

imply that only IBM's product, program, or service may be used. Any functionally
equivalent program that does not infringe any of IBM's intellectual property rights
may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment
specified, and is limited in application to those specific hardware and software
products and levels.

IBM may have patents or pending patent applications covering subject matter in
this document. The furnishing of this document does not give you any license to
these patents. You can send license inquiries, in writing, to the IBM Director of
Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact IBM Corporation, Dept.
600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal
IBM test and is distributed AS IS. The use of this information or the
implementation of any of these techniques is a customer responsibility and
depends on the customer's ability to evaluate and integrate them into the
customer's operational environment. While each item may have been reviewed
by IBM for accuracy in a specific situation, there is no guarantee that the same or
similar results will be obtained elsewhere. Customers attempting to adapt these
techniques to their own environments do so at their own risk.
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Any pointers in this publication to external Web sites are provided for
convenience only and do not in any manner serve as an endorsement of these
Web sites.

The following terms are trademarks of other companies:

Tivoli, Manage. Anything. Anywhere.,The Power To Manage., Anything.
Anywhere., TME, NetView, Cross-Site, Tivoli Ready, Tivoli Certified, Planet Tivoli,
and Tivoli Enterprise are trademarks or registered trademarks of Tivoli Systems
Inc., an IBM company, in the United States, other countries, or both. In
Denmark, Tivoli is a trademark licensed from Kjgbenhavns Sommer - Tivoli A/S.

C-bus is a trademark of Corollary, Inc. in the United States and/or other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and/or other
countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States and/or other countries.

PC Direct is a trademark of Ziff Communications Company in the United States
and/or other countries and is used by IBM Corporation under license.

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel
Corporation in the United States and/or other countries.

UNIX is a registered trademark in the United States and other countries licensed
exclusively through The Open Group.

SET, SET Secure Electronic Transaction, and the SET Logo are trademarks
owned by SET Secure Electronic Transaction LLC.

Other company, product, and service names may be trademarks or service
marks of others
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